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TUYÊN BỐ BẢN QUYỀN
Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được phép

dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo.
Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh thiếu

lành mạnh sẽ bị nghiêm cấm.

LỜI NÓI ĐẦU
Đã từ lâu, các KTV đồ họa, họa sĩ, các nhà xử lý ảnh đều xem các phần mềm Corel

Draw, Adobe Photoshop như là công cụ không thể thiếu được trong thiết kế xử lý ảnh.
Chính vì thế môn học đồ họa ứng dụng (sử dụng phần mềm Adobe Photoshop) được
tổng cục dạy nghề đưa vào Mô đun Xử lý ảnh là môn học bắt buộc thuộc nhóm các mô
đun chuyên môn nghề được bố trí giảng dạy sau các môn chung của chương trình đào
tạo Cao đẳng nghề, Trung cấp nghề Công nghệ thông tin (ứng dụng phần mềm).

Giáo trình ngôn ngữ Đồ họa ứng dụng được biên soạn bám sát với nội dung chương
trình khung mô đun “Đồ họa ứng dụng” ngành Công nghệ thông tin do tổng cục dạy
nghề ban hành đang được giảng dạy tại trường.

Giáo trình “Đồ họa ứng dụng” trình bày các kỹ thuật xử lý ảnh từ cơ bản đến nâng
cao các tính năng mới giúp bạn tạo được các hình rõ nét, và mang tính kỹ thuật cao, hỗ
trợ đắc lực cho kỹ thuật tách ghép hình ảnh, điều chinh màu sắc; Phục hồi được ảnh
cũ, nhàu, ố,...; Tạo hiệu ứng cho bức ảnh, lồng ghép khung ảnh nghệ thuật; Chen chữ
nghệ thuật vào trong bức ảnh; Xuất ảnh với nhiều đinh dạng khác nhau; In ảnh với
màu sắc trung thực…

Để có thể đọc hiểu giáo trình này người đọc cần nắm vững các kiến thức về: Tin
học cơ bản, Tin học văn phòng, làm chủ việc duyệt và quản lý thông tin trong máy
tính. Tìm hiểu những thuật ngữ của xử lý ảnh. Trong quá trình biên soạn chắc chắn
không thể tránh khỏi những sai sót. Rất mong nhận được những ý kiến đóng góp của
quý thầy cô, các đồng nghiệp và bạn đọc để có thể hoàn thiện hơn giáo trình này phục
vụ cho việc học tập của sinh viên, học sinh.

Xin chân thành cảm ơn!
Củ chi, ngày ... tháng ... năm 2021

Tham gia biên soạn
1. Lê Bá Thi
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CHƯƠNG TRÌNH MÔ ĐUN
(Kèm theo Thông tư số: 03/2017/TT-BLĐXH ngày 01/03/2017

Của Bộ trưởng Bộ Lao động – Thương binh và Xã hội)
Tên mô đun: ĐỒ HOẠ ỨNG DỤNG
Mã số mô đun: MĐ 24
Thời gian mô đun: 75 giờ (Lý thuyết: 15 giờ; Thực hành: 55 giờ; Kiểm tra: 5 giờ)
I. VỊ TRÍ, TÍNH CHẤT MÔ ĐUN:

Vị trí của mô đun : Mô đun được bố trí sau khi học sinh học xong các môn học
chung, trước các môn học, mô đun đào tạo chuyên môn nghề.

Tính chất của mô đun : Là mô đun chuyên ngành tự chọn.
II. MỤC TIÊU MÔ ĐUN:

Về kiến thức:
Trình bày được khái niệm và các kỹ thuật của phần mềm đồ họa Photoshop;

Về kỹ năng:
Khái niệm và các kỹ năng của phần mềm đồ họa Photoshop.
Hiệu chỉnh hình ảnh chọn kích thước file ảnh phù hợp từng yêu cầu và chất

lượng hình ảnh tốt nhất.
Xử lý lắp ghép tạo hiệu ứng cho hình ảnh.
Biết nhập chữ vào hình ảnh.
Biết cách thức phối màu cho hình ảnh.

Về năng lực tự chủ và trách nhiệm:
Rèn luyện lòng yêu nghề, tư thế tác phong công nghiệp, tính kiên trì, sáng tạo

trong công việc, trao đổi học hỏi bạn bè, làm việc nhóm, trách nhiệm với môn học, nội
quy thực hành, khả năng tự tìm hiểu.

Rèn luyện trách nhiệm tự học, tự tìm hiểu thêm về môn học.
Thực hiện an toàn sử dụng máy tính, điện, trách nhiệm với trang thiết bị phòng học.
Bố trí làm việc khoa học đảm bảo an toàn cho người và phương tiện học tập.
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BÀI 1. TỔNG QUAN VỀ ADOBE PHOTOSHOP
Giới thiệu

Trong bài này giới thiệu cho học sinh biết về phần mềm xử lý ảnh và các thao tác cơ
bản trên trình đơn và tạo được tập tin theo kích thước.
1. Mục tiêu:

- Hiểu được phần mềm xử lý ảnh.
- Thực hiện được các thao tác trên trình đơn và tạo được tập tin theo kích thước.
- Cẩn thận, thao tác nhanh chuẩn xác, tự giác trong học tập

2. Nội dung bài học
2.1 Giới thiệu
2.1.1 Phần mềm PhotoShop

Adobe Photoshop  (thường được gọi là Photoshop) là một phần mềm chinh sửa đồ
họa được phát triển và phát hành bởi hãng Adobe Systems ra đời vào năm 1988 trên hệ
máy Macintosh.  Photoshop được đánh giá là phần mềm dẫn đầu thi trường về sửa ảnh
bitmap và được coi là chuẩn cho các ngành liên quan tới chinh sửa ảnh. Từ phiên bản
Photoshop 7.0 ra  đời  năm 2002,  Photoshop đã làm lên một cuộc cách mạng về ảnh
bitmap. Phiên bản mới nhất hiện nay là Adobe Photoshop CC.

Ngoài khả năng chính là chinh sửa ảnh cho các ấn phẩm, Photoshop còn được sử dụng
trong các hoạt động như thiết kế trang web, vẽ các loại tranh (matte painting và nhiều thể
loại khác), vẽ texture cho các chương trình 3D... gần như là mọi hoạt động liên quan đến
ảnh bitmap.

Adobe Photoshop có khả năng tương thích với hầu hết các chương trình đồ họa khác
của Adobe như Adobe Illustrator,   Adobe Premiere,   After After Effects và Adobe Encore.
2.1.2 Các khái niệm trong PhotoShop
2.1.2.1. Điểm ảnh (pixcel)

Là những hình vuông cấu tạo nên file ảnh. Số lượng và độ lớn của điểm ảnh trong 1
file phụ thuộc vào độ phân giải của nó.
2.1.2.2 Độ phân giải (Resolution)

Là lượng điểm ảnh trên cùng một đơn vi dài. Nếu nói độ phân giải của anh bằng 72,
tức là có 72 điểm ảnh trên một inch dài.
2.1.2.3. Vùng chọn (Selection)

Là miền được giới hàn bằng đường biên nét đứt (đường kiến bò), mọi thao tác xử lý
chi có tác dụng bên trong vùng chọn.
2.1.2.4. Lớp ảnh (Layer)

Trong một layer có chứa các vùng chọn có điểm ảnh và không có điểm ảnh
Màu hậu cảnh: Background.
Màu tiền cảnh: Là màu được tô vào ảnh.
Màu hậu cảnh: Là màu được tô vào giấy.

2.2 Các tính năng trên trình đơn
2.2.1. Giao diện chương trình

Cửa sổ giao diện của Photoshop bao gồm 6 thành phần cơ bản:
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Thanh tiêu đề, Thanh trình đơn (menu bar), thanh option, thanh trạng thái, hộp công cụ
và các Palettes.

Hì
nh 1.1 Cửa sổ giao diện của chương trình Photoshop CS2

Thanh trình đơn (menu bar): Chứa toàn bộ các lệnh của Photoshop, được bố trí vào
trong các trình đơn chính sau

Hình 1.2 Thanh trình đơn (Menu bar)
File: chứa các lệnh về đóng mở, tạo ảnh mới…
Edit: chứa lệnh về copy, cut, paste, tô màu hay xoay ảnh
Image: Chứa các lệnh để thay đổi thuộc tính hay chinh sửa
Layer: chứa các lệnh thao tác với layer
Select: tao tác với vùng chọn, lưu, hủy chọn…
Filter: chứa các nhóm bộ lọc của Photoshop
View: Chứa các lệnh xem ảnh
Window: Bật/tắt các Paletter
Thanh tùy chọn công cụ (Option bar): Chứa các lệnh tùy chinh phục vụ cho thao tác

ứng với công cụ đang chọn .Tùy vào công cụ được chọn mà các lệnh trên thanh này sẽ
thay đổi tương ứng.

Cửa sổ thiết kế:  Các bảng (Palettes): Giúp cho việc giám sát và chinh sửa dễ dàng
hơn.

Hộp công cụ (Tools box/ Tools bar): Chứa các công cụ thường được sử dụng trong
Photoshop .Thông thường các phiên bản càng mới thì hộp công cụ gồm nhiều công cụ
hơn.
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Hình 1.3 Các lệnh trên hộp công cụ (Tools Option)
2.3 Tạo mới tập tin ảnh
2.3.1 Môi trường làm việc

Các thao tác di chuyển và phóng ảnh: Để di chuyển và phóng ảnh ta có thể dùng bảng
Nevigator

Các lệnh thu - phóng ảnh: Công cụ thu phóng ảnh: Zoom tool
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Lệnh cuộn ảnh: Công cụ Hand tool
2.3.2 Thao tác với file ảnh
2.3.2.1 Mở file ảnh

Chọn[Menu] File > Open và tìm đến file cần mở

Hình 1.4 Hộp thoại Open 
Chọn file cần mở và nhấn Open.

2.3.2.2 Tạo file mới
- Chọn [Menu]File > New (Ctrl + N)
- Khai báo hộp thoại New

Hình 1.5 Hộp thoại New
Name: Nhập tên file ảnh
Preset: thiết lập các thông số bức ảnh
Width: Nhập kích thước chiều rộng ảnh
Height: Nhập kích thước chiều cao ảnh
Resolution: Chọn độ phân giải của ảnh
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Color Mode: Chọn chế độ màu của ảnh
Background Contents: Chọn nền cho ảnh
White: Nền trắng
Transparency: Nền trong suốt
Color: Ấn đinh màu trong bảng màu cho nền Chọn nút OK.

2.3.2.3. Lưu file ảnh
- Chọn [Menu]File > Save (Ctrl + S)
- Khai báo hộp thoại Save

Hình 1.6 Hộp thoại Save File name: Nhập tên file ảnh cần lưu
Format: Chọn đinh dạng ảnh cần lưu
Chọn nút Save.
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BÀI 2. CÁC NÚT LỆNH TRÊN THANH CÔNG CỤ
Giới thiệu

Trong bài này giới thiệu cho học sinh biết về chức năng các nút lệnh trên thanh công
cụ của Photoshop.
1. Mục tiêu:

Biết được cách thức sử dụng của từng công cụ trên thanh công cụ
Thao tác được cách nhập chữ trong hình ảnh.
Có tin thần học tập nghiêm túc, rèn luyện tính tỉ mỉ, chịu khó

2. Nội dung:
2.1 Nhóm công cụ chọn vùng và hiệu chỉnh vùng chọn
2.1.1 Bộ công cụ Marquee

Nhóm công cụ Marquee tool dùng để tạo vùng chọn hình chữ nhật, hình ellipe, một
đường ngang và một đường đứng.

Rectangular Marquee : tạo một vùng chọn là hình chữ nhất trên ảnh
Eliptical Marquee : Tạo vùng chọn là Elip hoặc hình tròn
Signle Row Marquee và Single column Marquee : tạo vùng chọn là một dòng cao 1

px hoặc rộng 1px
2.1.2 Bộ công cụ Lasso Tool

Nhóm công cụ Lasso tool dùng để tạo vùng chọn có hình dạng bất kỳ

Hình 2.1 Nhóm công cụ Lasso
Lasso: đưa một vùng chọn tự do,điểm cuối cùng trùng điểm đầu tiên để tạo nên một

vùng chọn khép kín

Hình 2.2 Thanh tùy chọn công cụ Lasso
Polygon lasso : Nối các đoạn thẳng để tạo nên một vùng chọn

Hình 2.3 Thanh tùy chọn công cụ Polygonal Lasso
Magnetic Lasso : công cụ chọn có tính chất bắt dính vào biên của ảnh có sắc độ tương

đồng
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Hình 2.4 Thanh tùy chọn công cụ Magnetic Lasso
2.1.3 Công cụ Magic Wand
Dùng để tạo vùng chọn là các điểm ảnh tương tự như điểm ảnh tại nơi click chuột.

Hình 2.5 Thanh tùy chọn công cụ Magic Wand 
2.1.4 Công cụ Crop
Dùng để cắt xén hình ảnh

Hình 2.6 Thanh tùy chọn công cụ Crop
2.1.5 Các thao tác xoay ảnh

Thực hiện
Tạo vùng chọn hoặc chọn lớp ảnh cần thao tác
[menu]Edit  > Transform > Rotate

Nhập góc cần xoay ảnh hoặc Drag góc của các handle xung quanh ảnh để xoay theo
hướng cần thao tác (hoặc chọn một trong những kiểu xoay ảnh đặc biệt: quay 180 0, 900

CW (cùng chiều kim đồng hồ) hoặc 900 ngược chiều kim đồng hồ)
2.1.6 Lệnh Free Transform

Dùng để xoay, thay đổi kích thước ảnh, xô nghiêng, lật ảnh... tự do
Thực hiện:

Tạo vùng chọn hoặc chọn lớp ảnh cần thao tác
[menu] Edit > Free Transform
Thao tác với các handle xung quanh ảnh để thực hiện chinh sửa ảnh
Nhấn Enter để kết thúc việc chinh sửa.

2.1.7 Các lệnh Transform khác

Hình 2.8 Các lệnh trong thao tác thay đổi ảnh (Transform)
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Thực hiện:
Chọn Menu Edit / Transform ( Ctrl+T)

Scale: Co giãn vùng ảnh chọn hoặc đối tượng ảnh trên layer
Skew: Làm nghiêng vùng chọn hoặc đối tượng ảnh trên layer.
Distort: Hiệu chinh biến đổi dạng hình ảnh.
Perspective: Thay đổi phối cảnh của vùng chọn.
Rotate: Xoay vùng ảnh hoặc đối tượng ảnh trên layer.
Number: Tính chính xác theo điểm ảnh.
Elip horizonta: Lật theo phương dọc.
Elip Vertical: Lật đối xứng theo phương ngang.

2.2 Nhóm công cụ vẽ và tô màu
2.2.1 Spot Healing Brush Tool, Healing Brush Tool, Patch Tool, Red Eye Tool

Những công cụ này là rất quan trọng nếu bạn đang làm rất nhiều chỉnh sửa khuôn
mặt. Spot Healing Brush Tool là dễ nhất để sử dụng khi bạn học photoshop.

Bạn chỉ đơn giản là tìm sự không hoàn hảo da bạn muốn loại bỏ và nhấn vào nó. Đây
không phải là kỹ thuật tiên tiến nhất để làm cho làn da sạch sẽ, nhưng nó là một công cụ
cơ bản và rất nhanh.

Hình 2.9 Nhóm công cụ vẽ và tô màu
Bạn có thể nhìn thấy trong hình dưới đây một trước và sau. Tôi chỉ đơn giản là nhấp

vào các điểm đánh dấu với Spot Healing Brush Tool và Photoshop tạo ra một số da tốt
dựa trên những chỗ nhấp và các khu vực xung quanh.

Hình 2.10 Minh họa nhóm công cụ vẽ và tô màu
Healing Brush Tool là giống như Spot Healing Brush Tool với sự khác biệt mà nó đòi

hỏi bạn phải thiết lập một điểm mẫu để Photoshop sẽ căn cứ giải thuật chữa bệnh của nó
vào khu vực của hình ảnh thiết lập như là điểm mẫu. Để đơn giản hơn: bạn sẽ chữa lành
tất cả các điểm tiếp theo của bạn dựa trên khu vực bạn Alt-nhấp vào.
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Công cụ Patch Tool là một công cụ rất hữu ích cho việc pha trộn liền mạch của da
hoặc các bề mặt đồng phục khác. Hãy để chúng tôi nói rằng tôi muốn loại bỏ các túi thâm
dưới mắt của cô gái. Tôi có thể sử dụng Spot Healing Brush Tool một cách dễ dàng hơn.
Trong hình dưới đây, tôi chọn công cụ Patch và tạo ra một vùng chọn như hình bên dưới.
Bây giờ chỉ cần kéo các lựa chọn thấp hơn một chút ba lần và phát hành. Điều này sẽ tạo
ra làn da trong khu vực được lựa chọn dựa trên các khu vực mà từ đó chúng ta kéo vùng
lựa chọn. Toàn bộ quá trình là done dễ dàng hơn nói vì vậy tốt nhất là bạn hãy thử nó và
xem cho chính mình.

Hình 2.11 Minh họa nhóm công cụ vẽ và tô màu
Bạn có thể xem kết quả của tôi dưới đây. Có một sự khác biệt tinh tế, nhưng đáng chú

ý nhưng đó là những gì bạn có thể sẽ muốn khi thực hiện bức chân dung chỉnh sửa
với Photoshop.  Mặt  khác,  chúng  ta  hãy  nói  rằng  bạn  sử  dụng Spot  Healing  Brush
Toolnhư điên một số phần trông giả và không phù hợp với phần còn lại của khuôn mặt.
Không có vấn đề gì. Chọn khu vực phiền hà với các công cụ vá rồi kéo và thả các lựa
chọn một vài lần trong những phần tốt xung quanh của da. Ở đó, vấn đề giải quyết. Một
lần nữa, những điều này là phức tạp hơn nhiều để viết hơn để làm.

Hình 2.12 Minh họa nhóm công cụ vẽ và tô màu
Cuối cùng, Red Eye Tool đòi hỏi bạn phải chọn một iris với một vấn đề mắt đỏ và nó

cố gắng để loại bỏ hiện tượng mắt. Mặc dù có những cách nâng cao hơn để làm điều đó
(với Curves hoặc Channels) công cụ này làm một công việc khá tốt.
2.2.2 Brush Tool, Pencil Tool, Color Replacement Tool, Mixer Brush Tool

Hình 2.13 Nhóm công cụ Brush Tool, Pencil Tool,
Color Replacement Tool, Mixer Brush Tool
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Các công cụ Brush có lẽ là công cụ được sử dụng nhất trong bảng điều khiển Toolbar.
Bạn có thể sử dụng nó để vẽ với các pixel trên hình ảnh của bạn. Các công cụ brush tròn
là một trong những lựa chọn theo mặc định khi bạn lần đầu tiên mở Photoshop, do đó bạn
có lẽ đã chơi với nó một chút. Brush này có hai thiết lập quan trọng bạn sẽ muốn chơi
với: kích thước và độ cứng. Độ cứng thể hiện như thế nào xác định các cạnh của bàn chải
là (hoặc làm thế nào mờ). Thiết lập độ cứng thiết lập để tối đa (100%) và bạn sẽ vẽ với
nét cứng xấu xí.

Hình 2.14 Minh họa nhóm công cụ Brush Tool, Pencil Tool,
Color Replacement Tool, Mixer Brush Tool

Đặt  nó  vào  tối  thiểu  và  bạn  sẽ  có  một  số  nét  mờ  tốt  đẹp  mà  hòa  trộn  tốt
với background.

Hình 2.15 Minh họa nhóm công cụ Brush Tool, Pencil Tool,
Color Replacement Tool, Mixer Brush Tool

Trong tùy chọn bàn chải bảng điều khiển (thường là bạn có thể tìm thấy các tùy chọn
bảng điều khiển ở phía trên, ngay bên dưới thanh menu) bạn cũng có thể thay đổi chế độ
hòa trộn của bàn chải. Kết hợp với chế độ hòa trộn của layer tùy chọn này cung cấp cho
bạn một số tùy chọn cực kỳ sáng tạo. Một phím tắt hữu ích cho công cụ Brush là chìa
khóa khung ([/]). Click phím khung trái làm giảm kích thước của brush trong khi phím
dấu ngoặc vuông phải tăng kích thước. Giữ phím Shift trong khi bấm phím khung cho
phép bạn để tăng/giảm độ cứng của brush.

Hình 2.16 Nhóm công cụ Brush Tool, Pencil Tool,
Color Replacement Tool, Mixer Brush Tool

Các công cụ Brush tròn, không phải là công cụ duy nhất có sẵn: Photoshop cung cấp
cho bạn một loạt các bàn chải hình dạng khác nhau cho các nhu cầu của bạn.
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Hình 2.17 Nhóm công cụ Brush Tool
Không có vấn đề gì. Bạn có thể tạo các mẫu cọ của riêng bạn. Tạo một layer mới, vẽ

một cái gì đó với một bàn chải màu đen sau đó chọn Edit> Define Brush Preset.

Hình 2.18 Minh họa nhóm công cụ Brush Tool
Cung cấp cho nó một cái tên và bạn có một bàn chải mới.

Hình 2.19 Minh họa nhóm công cụ Brush Tool
Chúng ta hãy vẽ một cái gì đó với bàn chải mới được tạo
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Hình 2.20 Minh họa nhóm công cụ Brush Tool
Chọn Window> Brush để mở bảng điều khiển brush và tận hưởng vô số các thiết lập

cho brush mới tạo của bạn. Chúng ta có thể thêm các kết cấu trên của chúng tôi, làm cho
nó xoay ngẫu nhiên, làm cho nó phân tán, thêm brush trên đầu trang của nó và nhiều thứ
khác. Đi trước, mở bảng điều khiển brush và chơi với các thiết lập. Bạn có thể tạo ra một
số bàn chải khá mát mẻ với nó.

Hình 2.21 Minh họa nhóm công cụ Brush Tool
Các công cụ Pencil Tool cơ bản là một phiên bản xuống cấp của các công cụ Brush.

Bạn không cần phải là một lựa chọn độ cứng (trong thực tế, bạn có một thanh trượt độ
cứng nhưng cách kéo nó không thay đổi điều gì), nhưng bạn có hầu như tất cả các tính
năng của công cụ Brush Tool. Bạn có thể sẽ quan tâm đến các công cụ Pencil Tool nếu
bạn làm điểm ảnh nghệ thuật.

Công cụ thay thế Color cho phép bạn thay thế một màu sắc với nhau. Nó có một loạt
các thiết lập trong Options panel và nó cung cấp một số kết quả thú vị, nhưng phải trung
thực tôi hầu như không sử dụng nó. Có tốt hơn, cách chính xác hơn để thay thế một số
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màu sắc với màu sắc khác (ít nhất là đối với tôi) nên tôi sẽ không đi vào chi tiết về làm
thế nào để sử dụng nó.

Các Mixer  Brush  Tool là  nỗ lực của Photoshop để  bắt  chước hành vi  của hội  họa
truyền thống. Một lần nữa, tôi không sử dụng công cụ này ở tất cả nhưng nếu bạn đang
vào hội họa truyền thống .
2.2.3 Clone Stamp Tool, Pattern Stamp Tool

Hình 2.22 Nhóm công cụ Clone Stamp Tool, Pattern Stamp Tool
Công cụ Clone Stamp có lẽ là công cụ yêu thích của tôi và chắc chắn một trong tôi có

niềm vui nhất với (và Filter> Liquify). Nó có rất nhiều công dụng và nếu bạn đang làm
các thao tác hình ảnh thì đây là một công cụ để có quan hệ tốt.  Nó không phải là phức
tạp cả. Để sử dụng nó lần đầu tiên Alt-click vào một nơi nào đó để thiết lập vị trí mẫu.
Sau đó bắt đầu vẽ tranh. Bạn sẽ nhận thấy rằng bạn sẽ vẽ với các điểm ảnh bên dưới khu
vực lấy mẫu. Đó là tất cả công cụ này không. Nó bắt chước các lĩnh vực từ một phần của
hình ảnh trong các bộ phận khác. Nó rất hữu ích cho việc tạo ra nội dung mới dựa trên
mẫu có sẵn và loại bỏ các khiếm khuyết da hoặc các đối tượng không mong muốn.

Công cụ Pattern Stamp cho phép bạn vẽ với mẫu mong muốn trên ảnh. Không bao giờ
có một sử dụng cho nó!
2.2.4 History Brush Tool, Art History Brush Tool

Hình 2.23 Nhóm công cụ History Brush Tool, Art History Brush Tool
History Brush Tool là một điều thú vị ít chứa rất nhiều năng lượng. Nó cho phép bạn

vẽ trên một layer mới từ một trạng thái trước đó của hình ảnh của bạn. Hãy nói rằng bạn
cũng chỉnh sửa một bức ảnh nhưng bạn vẫn muốn một số cái nhìn ban đầu trong khu vực
nhất  định.  Để  làm  được  điều  này  trước  tiên  hãy  chọn  một  trạng  thái  trước  đó.
Mở Window > History và nhấp chuột vào một trong các ô vuông nhỏ bên cạnh tên của
các trạng thái mong muốn. Trong hình ảnh dưới đây thông báo rằng tôi nhấp vào hộp nhỏ
bên cạnh trạng thái cao nhất của hình ảnh – bản gốc. Bây giờ nếu tôi tạo một layer mới và
sơn với lịch sử Brush Tool tôi có thể phục hồi những vùng nhất định của hình ảnh của tôi
để tình trạng ban đầu của họ.
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Hình 2.24 Minh họa Nhóm công cụ
History Brush Tool, Art History Brush Tool

Cá nhân tôi thấy nó là một công cụ rất mạnh mẽ, nhưng công việc của tôi là dựa trên
các lớp điều chỉnh và chỉnh sửa không phá hủy vì vậy tôi không thấy sự cần thiết cho
các History Brush Tool. Đó là một công cụ rất phổ biến trở lại trong ngày khi các tính
năng chỉnh sửa không phá hủy của Photoshop rất hiếm.

Art History Brush Tool là một công cụ kỳ lạ mà cho phép bạn vẽ từ tình trạng trước đó
của hình ảnh, hình dạng tự động thay đổi.
2.2.5. Eraser Tool, Background Eraser Tool, Magic Eraser Tool

Công cụ Eraser cho phép bạn xóa(erase) pixels từ một lớp pixel (hoặc một lớp mask).
Nó là đơn giản như vậy. Bạn không thích cách lớp sơn mới của bạn sẽ, bạn chọn công cụ
Eraser và gửi điểm ảnh vào quên lãng. Ngoài ra, nếu bạn thông minh bạn có thể sử dụng
một lớp mask và không phá hủy loại bỏ các điểm ảnh không mong muốn khi trong quá
trình học photoshop cơ bản.

Khi làm việc trên một tài liệu Photoshop nó rất quan trọng để có thể quay trở lại và
làm lại hoặc sửa đổi một số hành động cũ của bạn. Điều này cung cấp cho bạn sức mạnh
để vô tinker với các thiết lập và điều chỉnh mà không làm mất dữ liệu vĩnh viễn. Đó là lý
do tại sao tôi khuyên bạn nên tránh xa các Công cụ Eraser Tool càng nhiều càng tốt và đi
cho lớp mặt nạ để thay thế. Một chút khéo léo để hiểu lúc đầu nhưng họ là hoàn toàn
xứng đáng với công sức.

Hình 2.25 Nhóm công cụ Eraser Tool,
Background Eraser Tool, Magic Eraser Tool

Công cụ Background Eraser là như Công cụ Color Replacement Tool, nhưng thay
vì thay thế các màu sắc mà bạn xóa nó. Nó là một công cụ khá cho việc loại bỏ một số
phần của hình ảnh nhưng không đủ chính xác. Có những công cụ tốt hơn nhiều lựa chọn
và kỹ thuật (như channel và Color Range) mà tôi không sử dụng công cụ này rất thường
xuyên.
2.2.6 Gradient Tool, Paint Bucket Tool
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Đầu tiên, chúng ta hãy quan sát công cụ Paint Bucket Tool. Nó là một công cụ ít sử
dụng tới và nghĩa là không bao giờ. Nếu bạn bấm vào với nó trên một hình ảnh nó sẽ lấp
đầy diện tích với màu nền trước. Nó có một thiết lập Tolerance trong các tùy chọn bảng
điều khiển mà làm việc cùng một cách như các thiết lập Tolerance cho Magic Wand
Tool.

Hình 2.26 Nhóm công cụ Gradient Tool, Paint Bucket Tool
Bây giờ Gradient Tool là một công cụ rất hữu ích và tôi thấy mình sử dụng nó trên

một cơ sở hàng ngày. Nó cho phép bạn tạo ra một gradient từ nền và màu nền trước. Các
phím tắt là G. Trong khi bạn có thể đạt được một số hiệu ứng nghệ thuật bằng cách kéo
công cụ Gradient trực tiếp trên lớp và sau đó có thể sử dụng Fade (Ctrl+Shift+F) và một
tùy chọn Opacity nó nhiều khả năng là bạn sẽ muốn sử dụng nó trong lớp mặt nạ. Bạn
muốn tạo  ra  một  hiệu  ứng Vignette?  Thêm một Layer  Curves  Adjustment,  kéo  cong
xuống dưới để làm tối và trong lớp mặt nạ kéo với Radial Gradient Tool (màu đen như
foreground, trắng làm nền).

Dưới đây là trước khi chỉnh: và sau khi chỉnh:

Hình 2.28 Minh họa Nhóm công cụ Gradient Tool, Paint Bucket Tool
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Điều này có thể không được tốt khi nhìn với hiệu ứng Vignette nhưng nó phục vụ cho
mục đích của bạn.
2.2.7 Blur Tool, Sharpen Tool, Smudge Tool

The Blur Tool và the Sharpen tool có một số mục đích: chúng làm giảm đi độ chuẩn và
làm sắc nét. Nó có 2 nhược điểm lớn: thứ nhất, chúng là bộ xử lý khá chuyên sâu, vì vậy
nếu bạn muốn làm việc nhanh chóng hoặc bạn có một máy tính chậm bạn sẽ phải chờ
đợi; Thứ hai, việc sử dụng chúng có nghĩa là bạn không được chỉnh sửa tài liệu của bạn
trong một cách không phá hủy. Nếu bạn muốn quay trở lại để xem trước của hình ảnh của
bạn thì bạn sẽ phải nhấn Ctrl + Z (Undo) như điên. Khi nói đến độ sắc nét và làm mờ tôi
thích để tạo layer tổng hợp từ tất cả các layer hiển thị (Ctrl+Shift+Alt+E), áp dụng một
sharpen filter/blur trên lớp này, thêm một layer mask và tô nó với màu đen và trắng để
hiện/ẩn layer.

Smudge Tool cho phép bạn “smudge” pixel. Đó là sử dụng chính nó để tạo ra tóc. Hãy
nói rằng tôi cắt và sao chép trong một tài liệu một con sói (hoặc một đầu người) nhưng
tôi không chọn những sợi lông rất tốt vì vậy nó trông giả. Sau đó, tôi sử dụng công cụ
smudge ở rìa của lông để cạnh tranh với tóc.

Trước khi dùng Smudge Tool: Sau khi dùng Smudge Tool:

Hình 2.29 minh họa Nhóm công cụ Gradient Tool, Paint Bucket Tool
2.2.8 Dodge Tool ,Burn Tool , Sponge Tool

Hình 2.30 Nhóm công cụ Dodge Tool ,Burn Tool , Sponge Tool
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Bây giờ đây là những công cụ khá tốt. Dodge Tool làm sáng và Burn Tool làm tối
trong khi ở thời tăng độ tương phản. Trong Options Bảng điều chỉnh có 2 thiết lập bạn
cần phải nhận thức: thiết lập phơi sáng và Protect Tones hộp kiểm. Bạn sẽ muốn có hộp
kiểm Protect Tones kiểm tra tất cả các thời gian, trừ khi bạn đang hướng tới hiệu ứng rất
mạnh mẽ. Các thiết lập phơi sáng ảnh hưởng đến sức mạnh của công cụ . Một mẹo nhanh
chóng: Nếu bạn đang sử dụng Dodge Tool giữ Alt để tạm thời chuyển sang Burn Tool và
ngược lại.

Việc thay thế không phá hủy vào 2 công cụ này là để tạo ra một layer mới, điền vào nó
với 50% màu xám màu (Shift + F5), thiết lập chế độ hòa trộn thành Overlay và sử dụng
Dodge và Burn hoặc một bàn chải màu đen và trắng trên lớp để đạt được tương tự hiệu
ứng.

Công cụ Sponge Giảm bão hoà các hình ảnh (hấp thụ màu sắc). Để có hiệu ứng tương
phản hơn hãy chắc chắn kiểm tra các hộp kiểm Vibrance trong Options Panel.
2.3 Công cụ tạo chữ

Công cụ Text trong Photoshop- Với mọi phần mềm, text (viết chữ) luôn là tính năng
quan trọng. Nhất là đối với những phần mềm đồ họa như Photoshop.Đặc biệt hơn, nếu
bạn là một người đam mê nghệ thuật Typography. Thì sử dụng thành thạo công cụ Text
trong Photoshop là nền tảng căn bản cho bạn.
2.3.1 Khái niệm công cụ Text.

Công cụ Text là công cụ dùng để tạo Layer, chữ hoặc đoạn văn bản.

Hình 2.31 Nhóm công cụ tạo chữ (Text) trong Photoshop
Nhóm công cụ Text trong Photoshop.
Horizontal Type Tool: Tạo chữ hoặc văn bản theo chiều ngang
Vertical Type Tool: tạo chữ hoặc văn bản theo chiều dọc
Horizontal Type Mask Tool: Tạo vùng chọn với hình dáng của chữ theo chiều ngang
Vertical Type Tool: tạo vùng chọn với hình dáng của chữ theo chiều dọc

2.3.2 Định dạng chữ.

Hình 2.32 Công cụ định dạng chữ
Chọn font chữ. Chọn style của chữ: Bold, Italic, v.v…
Chọn kích thước chữ.
Anti – alias: khử răng cưa cho nét chữ.

2.3.3 Căn lề cho chữ.
Ta có thể căn lề với 3 cách thức cơ bản: lề trái, giữa và phải trên thanh công cụ.

Hình 2.32 Công cụ canh lề
2.3.4 Đổi màu chữ.
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Hình 2.33 Công cụ đổi màu chữ
Khi click chọn vào ô màu trên thanh công cụ, Photoshop sẽ mở bảng Color Pickup. Và

chúng ta có thể chọn một màu bất kỳ.
Lưu ý: Để chuyển chữ in hoa sang chữ thường và ngược lại. Các bạn bôi đen chữ cần

chuyển và nhấn tổ hợp phím Ctrl+Alt+K (cho Win). Hoặc Cmd + Option +K (cho Mac).
2.3.5 Bảng Character Panel.

Hình 2.34 Công cụ Bảng Character Panel
Vào menu Window > Character để mở bảng hiệu chỉnh Character để mở bảng hiệu

chỉnh Charater (ký tự).
Các mục chú thích trong hình:
Font Family
Font size
Thu hẹp khoảng cách ký tự
Co giãn chiều cao chữ.
Khoảng cách chữ đường chân chữ
Định dạng chữ
Ký tự toán học đặc biệt
Font style
Khoảng cách dòng
Tăng khoảng cách ký tự
Co giãn chiều rộng chữ
Màu sắc chữ
Khử răng cưa

2.3.6 Bảng Paragraph Panel.
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Hình 2.35 Công cụ Bảng Paragraph Panel
Vào menu Window > Paragraph để mở bảng hiệu chỉnh Paragraph (đoạn văn)
Định dạng văn bản
Khoảng cách lề trái thụt vào
Khoảng cách lề trái thụt vào
Khoảng cách phía trên đoạn văn
Kiểu từ hiển thị khi xuống hàng
Khoảng cách lề phải thụt vào
Khoảng cách phía dưới đoạn văn

2.3.7 Công cụ Warp Text.

Hình 2.36 Công cụ Warp Text
Công cụ Warp Text dùng để biến dạng text. Có các kiểu biến dạng:
Style: các kiểu biến dạng
Horizontal / Vertical: hướng ngang hay đứng
Blend: hiệu chỉnh độ uốn cong
Horizontal Distortion: bóp méo theo hướng ngang
Vertical Distortion: bóp méo theo hướng đứng

Hình 2.37 Bảng Warp Text
2.3.8 Type on a Path.

23



Hình 2.38 Type on a Path
Thao tác:
Vẽ đường Path
Chọn công cụ Type tool, rê chuột vào đường path cho đến khi xuất hiện đường cong

bên dưới con trỏ chuột, click vào điểm trên đường Path để xác định vị trí chèn text
Nhập chữ vào
Chúng ta có thể sử dụng công cụ Direct Selection Tool (A) để: Di chuyển chữ trên

đường Path hoặc lật ngược nó lại.
Cách làm: Chọn công cụ Direct Section Tool: Rê chuột vào hình cho đến khi xuất hiện
mũi  tên  ở  phía  trái/  phải  con  trỏ  chuột,  kéo  rê  chuột  để  thay  đổi  vị  trí.
Lưu ý: Khi vẽ một shape bất kỳ, dùng công cụ Type Tool click vào trong shape. Nhập
chữ vào ta sẽ có chữ nằm trong hình dáng của shape đó.

Bài tập
Miêu tả hai cách để thay đổi tầm nhìn của một tấm hình.
Bạn chọn công cụ trong Photoshop và ImageReady như thế nào?
Hai cách nào để lấy thêm thông tin về Photoshop và ImageReady?
Miêu tả 2 cách để tạo ra hình ảnh trong Photoshop và ImageReady. Bạn làm thế nào để

nhảy từ Photoshop sang ImageReady và ngược lại?
Đáp án
Bạn có thể chọn lệnh từ menu View để phóng to hoặc thu nhỏ một tấm hình, hoặc bạn

có thể làm cho nó phủ đầy cửa sổ hình ảnh, bạn cũng có thể sử dụng công cụ phóng đại
và nhấp hoặc kéo chuột qua hình ảnh để phóng lớn hoặc thu nhỏ tầm nhìn. Hơn nữa, bạn
có thể dùng lệnh gõ tắt để phóng đại hoặc thu nhỏ một tấm hình. Bạn cũng có thể sử dụng
Navigator Palette để cuộn một tấm hình hoặc thay đổi độ phóng đại của nó mà không cần
sử dụng cửa sổ hình ảnh.

Để chọn công cụ, bạn có thể chọn công cụ trong hộp công cụ hoặc bạn có thể nhấn
phím tắt của công cụ đó. Công cụ đang dùng vẫn được chọn cho đến khi bạn chọn một
công cụ khác. Để chọn một công cụ ẩn, bạn có thể sử dụng tổ hợp phím hoặc luân phiên
nó đến công cụ mình cần, hoặc bạn có thể giữ chuột trên công cụ trong hộp công cụ để
mở menu xổ ra của công cụ ẩn.

Adobe Photoshop bao gồm phần trợ giúp, với tất cả thông tin về Adobe Photoshop CS
User Guide, bao gồm cả phím tắt, những thông tin thêm và hình minh hoạ. Photoshop
cũng có đường liên kết với trang chủ của Adobe System để cho bạn có thêm thông tin về
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dich vụ, sản phẩm và những mẹo nhỏ trong việc sử dụng Photoshop. ImageReady CS
cũng có phần trợ giúp và đường liên kết đến trang chủ của Adobe.
Bạn có thể tạo ra hình ảnh trong Photoshop và ImageReady hoặc bạn có thể lấy hình từ
bên ngoài như quét hình hoặc nhập hình được tạo bằng những trình đồ hoạ khác. Bạn
cũng có thể nhập hình ảnh đã được kỹ thuật số hoá từ trước như là những hình được tạo
ra bởi máy chụp kỹ thuật số hoặc bởi quá trình Kodak Photo CD.
Bạn có thể nhấp vào nút Jump to trong hộp công cụ hoặc chọn File Jump To để chuyển từ
Photoshop sang ImageReady và ngược lại.
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BÀI 3. SỬ DỤNG LỚP TRONG PHOTOSHOP
Giới thiệu

Trong bài này giới thiệu cho học sinh biết sử dụng các lớp (Player) để thực hiện được
cách thức lắp ghép hình ảnh.
1. Mục tiêu:

Trình bày được định nghĩa về lớp
Thực hiện được các thao tác trên lớp và tạo được hiệu ứng cho lớp
Thực hiện được cách thức lắp ghép hình ảnh.
Có tin thần học tập nghiêm túc, rèn luyện tính tỉ mỉ

2. Nội dung
2.1 Giới thiệu về lớp
2.1.1  Cơ bản về Layer

Hình 3.1 Bảng lớp và mô phỏng các lớp ảnh trong Photoshop
Mỗi file của Photoshop chứa một hoặc nhiều Layer riêng biệt. Một file mới thường là

một Background chứa màu hoặc ảnh nền mà có thể nhìn thấy được thông qua phần trong
suốt của các Layer tạo thêm sau. Bạn có thể quản lí các Layer bằng bảng hiển thị lớp.

Bảng lớp (Layer Palette): Dùng để quản lý lớp và vùng làm việc

Hình 3.2 Bảng lớp (Layers Pallete)
2.2 Các thao tác trong lớp
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2.2.1 Chọn Layer làm việc
Nhấp vào tên lớp hoặc hình ảnh thu nhỏ của (Thumbnai) trong Layer Palette.

2.1.2 Tạo lớp mới
[Menu] Layer > New hoặc chọn nút Create new Layer trên bảng lớp (Layer Palette)

2.1.3 Xoá bỏ lớp
Chọn lớp cần xóa, R_click chọn  Delete Layer (hoặc chọn lệnh Delete Layer) ở menu

con của bảng lớp. Hoặc Drag lớp thả vào biểu tượng thùng rác trên bảng lớp.
2.1.4 Copy 1 lớp

R_click tại lớp cần sao chép, chọn Duplicate Layer, nhập tên layer sao chép rồi ấn OK.
2.1.5 Thay đổi trật tự lớp

Drag (rê) lớp cần di chuyển rồi thả tới nơi cần thay đổi trên bảng lớp.
2.1.6 Ẩn, hiện các lớp

Click vào biểu tượng con mắt trước biểu tượng của lớp để Ẩn hoặc hiển thi lớp (khi có
biểu tượng con mắt là đang hiển thi lớp, khi không có biểu tượng con mắt là ngược lại)
2.1.7 Nối, mở nối các lớp

Nối các lớp: Chọn các lớp cần nối (chọn nhiều lớp ta nhấn giữ phím Shift rồi click vào
lớp cần chọn), click chọn biểu tượng móc xích (liên kết) hoặc chọn lệnh Link trong menu
lệnh Layer hoặc menu con của bảng lớp.
Tương tự để mở nối ta cũng thực hiện như thao tác nối nhưng lúc này trước tên lớp không
có hình sợi xích nữa.
2.1.8 Các lệnh dán lớp

Chọn vùng chọn hoặc chọn lớp nguồn, di chuyển đến nơi cần dán và thực hiện lệnh dán
[Menu] Edit > Paste hoặc (Ctrl + V) để dán (chương trình sẽ tự động tạo ra lớp mới).
2.1.9 Các chế độ hòa trộn

Thực chất chế độ hòa trộn là cách thức kết hợp với các pixel phông nền và pixel hòa trộn
để tạo ra hiệu quả đặc biệt nhằm làm cho ảnh trở nên sáng hơn, tối hơn hay thay đổi về màu
sắc cũng như kết cấu tùy thuộc vào từng chế độ hòa trộn.

Normal: Chế độ mặc đinh, màu hòa trộn thay thế màu nền
Dissole: Tạo hiệu ứng “cọ vẽ khô” trong đó số lượng pixels ngẫu nhiên được hòa trộn,

nếu đường biên có dùng fether thì hiệu ứng sẽ vỡ hạt ở đường biên.
2.1.10 Blending Mode (chế độ hoà trộn)

Thực hiện trộn màu giữa các layer với nhau, các mode trộn cho ta cảm giác ảnh trên
Layer này được hòa nhập vào ảnh trên layer khác.
Các Blending mode được bố trí ở ngay phía trên cửa sổ Layers:

Hình 3.3 Vi trí của các chế độ hòa trộn lớp trên bảng lớp
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Hình 3.4 Các nhóm hòa trộn lớp
Để sử dụng Blending mode, bạn cần chọn 1 hoặc nhiều hơn Layer khác nhau rồi lựa

chọn Blending mode tùy ý. Các Blending mode được chia thành 5 loại chính: Darken (làm
tối), Lighten (làm sáng lên), Saturation (độ đậm/nhạt màu), Subtraction (Lọc bỏ một số
phần) và Color (màu sắc).
Bạn nên hiểu những khái niệm sau đây về màu sắc khi thấy những hiệu ứng của chế độ hoà
trộn.

Màu cơ bản: là màu ban đầu của file ảnh
Màu hoà trộn: là màu được thiết lập bởi các công cụ vẽ hoặc những công cụ chinh sửa
Màu kết quả: là kết quả từ những chế độ hoà trộn được sử dụng
Khái quát về các chế độ hoà trộn: Những chế độ này là của những phiên bản mới nhất

của Photoshop, nhưng những hiệu ứng của nó thì như nhau trong tất cả các phiên bản
1. Normal

Hình 3.5 Hòa trộn Normal
Đây là chế độ mặc đinh của Photoshop. Không có một hiệu ứng hoà trộn nào được thiết

lập khi ở chế độ Normal.
2. Dissolve

Hình 3.6 Hòa trộn Dissolve 
Chinh sửa hoặc vẽ trên từng pixel để tạo ra màu kết quả. Tuy nhiên, màu kết quả là sự

thay đổi ngẫu nhiên của các giá tri pixel với màu cơ bản hoặc với màu hoà trộn, phụ thuộc
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vào mức Opacity tại bất cứ vi trí nào của pixel. Chế độ hoà trộn này kết hợp tốt với các
công cụ Paintbrush hoặc Airbrush và với kích cỡ lớn.
3. Behind

Chinh sửa hoặc vẽ chi trên những phần trong suốt của layer. Chế độ này chi làm việc
duy nhất với chức năng Preserve Transparency được tắt và tương tự để vẽ vào phần sau của
những vùng trong suốt.
4. Clear

Chinh sửa hoặc vẽ trên từng pixel để tạo ra trong suốt. Chế độ này chi làm việc với Line
tool,  Paint  bucket  tool,  các  lệnh  Fill  và  lệnh  stroke.  Bạn  phải  tắt  chế  độ  Preserve
Transparency để làm việc với chế độ này.
5. Multiply

Hình 3.7 Hòa trộn Multiply
Nó sẽ tìm những thông tin về màu trên từng kênh và nhân đôi màu cơ bản và màu hoà trộn.
Màu kết quả luôn luôn là một màu tối hơn. Nhân đôi bất cứ màu nào với màu đen sẽ cho
kết quả là đen, với màu trắng thì kết quả không đổi. Khi bạn vẽ với một màu nào đó mà
không phải là hai màu trắng và đen, với những nét vẽ liên tục với công cụ Painting sẽ tạo ra
một màu tối hơn. Hiệu ứng tương tự như khi vẽ trên một file ảnh với chiếc bút thần kỳ đa
chức năng.

6. Screen
Hình 3.8 Hòa trộn Screen

Với Screen nó sẽ tìm từng kênh thông tin màu và nhân với màu ngược lại của màu hoà
trộn và màu cơ bản. Màu kết quả sẽ luôn luôn là một màu sáng hơn. Nếu bạn thiết lập chế
độ Screen với màu đen thì màu sẽ không thay đổi, ngược lại, hoà trộn với màu trắng sẽ cho
ra màu trắng. Hiệu ứng này giống như kiểu chiếu sáng những tấm phim ảnh chồng lên
nhau.
7. Overlay

Hình 3.9 Hòa trộn Overlay
Nhân đôi hoặc che chắn màu phụ thuộc vào màu gốc. Khi được thiết lập nó sẽ lấy làm

mẫu hoặc che phủ những giá tri pixel của ảnh nhưng lại bảo tồn những vùng bóng sáng và
bóng đen của màu gốc. Màu gốc sẽ không bi thay đổi nhưng được trộn lẫn với màu hoà
trộn để phản xạ những vùng sáng hoặc vùng tối của màu ban đầu.
8. Soft Light
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Hình 3.10 Hòa trộn Soft Light
Làm sáng hoặc làm tối màu phụ thuộc vào màu hoà trộn. Hiệu ứng này tương tự như khi

ta chiếu sáng bằng một cái đen rọi tán sắc lên một bức ảnh. Nếu màu trộn (ánh sáng nguồn)
nhạt hơn 50% xám, file ảnh sẽ được làm sáng, như khi nó được Dodge. Nếu màu trộn tối
hơn 50% xám, file ảnh sẽ bì làm tối đi như khi nó được Burn. Vẽ với màu trắng hoặc đen
tuyệt đối sẽ tạo ra một vùng tối hoặc sáng khác biệt nhưng kết quả lại không phải là màu
đen hoặc trắng tuyệt đối.
9. Hard Light

Hình 3.11 Hòa trộn Hard Light 
Hiệu ứng này sẽ nhân đôi hoặc che chắn màu, phụ thuộc vào màu hoà trộn. Hiệu ứng

này tương tự như khi ta dùng một đen rọi cực sáng chiếu vào hình ảnh. Nếu màu hoà trộn
(ánh sáng nguồn) nhạt hơn 50% xám, hình ảnh sẽ được làm sáng như khi nó được áp dụng
hiệu ứng Screen.Điều này rất có ích khi ta muốn tạo những vùng phản chiếu cho một file
ảnh. Nếu màu hoà trộn đậm hơn 50% xám, nó sẽ có hiệu ứng như Multiplied. Điều này có
ích khi ta muốn thêm những vùng phủ bóng cho một file ảnh. Tô vẽ với màu đen và trắng
tuyệt đối sẽ cho kết quả là đen và trắng tuyệt đối.
10. Color Dodge

Hình 3.12 Hòa trộn Color Dodge 
Hiệu ứng này sẽ tìm những thông tin màu trên mỗi kênh và làm sáng màu gốc để phản

xạ màu hoà trộn. Nếu hoà trộn với màu đen sẽ không tạo ra thay đổi gì.
11. Color Burn

Hình 3.13 Hòa trộn Color Burn 
Hiệu ứng này sẽ tìm những thông tin màu trên mỗi kênh và làm tối màu gốc để phản xạ

màu hoà trộn. Nếu hoà trộn với màu trắng sẽ không tạo ra thay đổi gì.
12. Darken
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Hình 3.14 Hòa trộn Darken 

Hiệu ứng này tìm những thông tin màu trên mỗi kênh và chọn màu gốc và màu hoà trộn
(nó sẽ so sánh màu nào nào đậm hơn) để làm ra màu kết quả. Những pixel nào nhạt hơn
màu hoà trộn sẽ bi thay thế và những pixel nào đậm hơn màu hoà trộn sẽ không bi thay đổi.
13. Lighten

Hình 3.15 Hòa trộn Lighten
Hiệu ứng này tìm những thông tin màu trên mỗi kênh và chọn màu gốc và màu hoà trộn

(nó sẽ so sánh màu nào nhạt hơn) để làm ra màu kết quả. Những pixel nào đậm hơn màu
hoà trộn sẽ bi thay thế và những pixel nào nhạt hơn màu sẽ không bi thay đổi.
14. Difference

Hình 3.16 Hòa trộn Difference 
Nó tìm những thông tin màu trên từng kênh và nó sẽ hoặc là bớt đi ở màu hoà trộn từ

màu gốc hoặc là bớt đi ở màu gốc từ màu hoà trộn, phụ thuộc vào màu nào có giá tri sáng
hơn. Trộn với màu trắng sẽ đảo ngược giá tri màu gốc; trộn với màu đen sẽ không tao ra
thay đổi gì.
15. Exclusion

Hình 3.17 Hòa trộn Exclusion
Tạo ra hiệu ứng tương tự như Difference nhưng có độ tương phản thấp hơn chế độ

Difference. Trộn với màu trắng sẽ đảo ngược giá tri của màu gốc. Trộn với màu đen sẽ
không tạo ra thay đổi gì.
16. Hue

Hình 3.18 Hòa trộn Hue
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Tạo ra màu kết quả với độ chói và độ đậm của màu gốc và màu sắc của màu hoà trộn.
17. Saturation

Hình 3.19 Hòa trộn Saturation

Tạo ra màu kết quả với độ chói và màu sắc của Màu Gốc và độ đậm của màu hoà trộn.
Tô vẽ với chế độ này trong vùng với độ đậm bằng 0 sẽ không tạo ra thay đổi gì.
18. Color

Hình 3.20 Hòa trộn Color
Tạo ra màu kết quả với độ chói của Màu Gốc, màu và độ đậm của màu hoà trộn. Hiệu

ứng này bảo tồn mức độ xám của hình ảnh và hữu ích để tô màu cho những hình ảnh có
tính kim loại (Chrome) và dùng để tô màu cho hình ảnh.
19. Luminosity

Hình 3.21 Hòa trộn Luminosity
Tạo ra kết quả với màu và độ đậm của Màu Gốc, độ chói của màu hoà trộn. Hiệu ứng

này tạo ra tác động ngược lại với hiệu ứng Color.
Bạn có thể dùng Blending Mode để tạo ra các hiệu ứng một cách đơn giản hơn so với

các công cụ khác.
2.3 Tạo các hiệu ứng cho lớp.

Layer là thành phần cốt lõi  của một file Photoshop. Các hiệu ứng cho Layer trong
Photoshop là cần thiết để tạo ra một bức ảnh đẹp. Vì vậy mà việc hiểu rõ các hiệu ứng có
thể áp lên Layer là điều rất cần thiết.

Drop shadow: Tạo ra một cái bóng đắng sau nội dung Layer.
Inner shadow: Tạo ra một cái bóng đổ vào trong nội dung Layer.
Outer Glow: Tạo ra một ánh sáng tỏa vào bên trong nội dung Layer. Có thể không thể xa

như Drop shadow.
Inner Glow: Tạo ra một ánh sáng tỏa vào bên trong nội dung Layer. Một lân nữa, không

thể xa như Drop shadow.
Bevel and Emboss: Được sử dụng để tao điểm nhấn và bóng hiệu ứng độc đáo trên một

Layer.
Satin: Cung cấp cho các Layer hiệu ứng bóng như nước hoặc Plastic.
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Color Overlay: Đổ màu cho Layer với 1 màu duy nhất.
Gradient Ovelay: Đổ màu cho Layer với Gradient.
Pattern overlay: Tạo chất liệu cho Layer.
Stroke: Tạo ra đường viền cho Layer. Có thể sử dụng một màu sắc, Gradient, hoặc chất

liệu.

Hình 3.22 Các hiệu ứng trong Layer style
2.3.1 Layer styles option.

Altitude
Sử dụng cho Bevel and Emboss, tùy chỉnh chiều cao của ánh sáng nguồn.

Nếu đặt ở 0 thì tương đương với mặt phẳng của Layer, 90 thì nằm trên Layer
Angle

Xác định góc chiếu mà tại đó các hiệu ứng được áp dụng cho các lớp.
Bạn có thể kéo khung hiển thị để tùy chỉnh góc độ của Drop Shadow. Inner Shadow hay

Satin.
Anti alias

Hòa trộn các điểm ảnh góc cạnh của một đường viền hay bóng cả đường viền.
Tùy chọn này rất hữu ích cho những vêt bóng nhỏ hoặc những đường phức tạp
Blend Mode

Chế độ hòa trộn của Layer style so với Layers bên dưới nó.
Có thể bao gồm hoặc không bao gồm các Layer đang hiển thị.

Choke
Tạo 1 lớp ranh giới giữa Layer và hiệu ứng Inner Shadow trước khi làm nhòe. Hoặc

lớp ranh giới giữa Layer và hiệu ứng Inner Glow trước khi làm nhòe
Color
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Bạn có thể click vào và chọn màu cho Shadow, Glow hoặc Highlight.
Contour

Với Solod-color Glows, Contour cho phép bạn tạo một vòng tròn với độ trong suốt.
Với Gradient-filled Glows, Contour cho phép tạo các biển thể lặp lại của Gradient và

Opacity.
Với Bevel and Emboss, Contour cho phép tạo những vùng nổi, vùng chìm, vùng lồi

lõm. Hoặc những vạt mờ trong quá trình tạo khối.
Distance

Xác định khoảng cách từ Layer xuống hiệu ứng, dành cho Shadow hoặc Satin. Bạn có
thể kéo vùng điều khiển để tùy chỉnh.

Depth
Xác định độ dày của một góc xiên, cũng như xác định độ dày của Pattern.

Use Global Light
Nếu tùy chọn này được chọn, tất cả các hiệu ứng Drop Shadow, Inner Shadow, Bevel

and Emboss sẽ xài chung một nguồn sáng. Khi bạn thay đổi nguồn sáng của một trong
những hiệu ứng đó, các hiệu ứng cho Layer trong Photoshop khác cũng sẽ tự thay đổi theo.

Nếu tùy chọn này không được chọn, bạn chỉ thay đổi nguồn sáng cho một hiệu ứng
duy nhất đang điều chỉnh. Không ảnh hưởng đến những hiệu ứng khác.

Gloss contour
Tạo ra những vệt bóng hay kim loại.  Thường được sử dụng cho những cạnh của

Bevel and Emboss.
Gradient

Áp tô màu chuyển sắc cho hình, cách sử dụng giống công cụ Gradient.
Highlight or Shadow mode

Tạo chế độ hòa trộn của Bevel and Emboss là vùng sáng hay vùng tối.
Jilter

Thay đổi cấc ứng dụng màu và Opacity của Gradient.
Layer knocks out drop shadow

Kiểm soát các độ đổ bóng của những Layer gần như trong suốt.
Noise

Chỉ định một số ngẫu nhiên cho độ mờ đục của ánh sáng hay bóng tối.
Nhập thông số hoặc kéo thanh trượt để tùy chỉnh

Opacity
Độ mờ đục của hiệu ứng, có thể nhập thông số hoặc kéo thanh trượt.
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Hình 3.23 Hiệu ứng Opacity đối với Layer
Pattern

Áp một Pattern lên cho Layer. Pattern là một hình ảnh nhỏ được sử dụng để tự động
xuất hiện lặp đi lặp lại theo chiều ngang và chiều dọc. Cho đến khi đầy toàn bộ tấm hình.

Position
Xác định vị trí của viền hiệu ứng là Outside (đổ ra ngoài), Inside (đổ vào trong) hay

Center (nằm giữa).
Size: Xác định thông số và mức độ nhòe của bóng đổ.
Range: Kiểm soát thông số và mức độ nhòe của bóng đổ.
Soften: Làm mềm các kết quả để hạn chế những hiệu ứng không mong muốn.
Source:  Xác định nguồn gốc cho Inner Glow. Chọn Center để áp ánh sáng từ tầm của

Layer; Hoặc chọn Edge để áp ánh sáng từ cạnh của Layer.
Spread: Mở rộng ranh giới của các hiệu ứng làm nhòe.
Style: Các kiểu hiệu ứng khác nhau, áp dụng cho Bevel and Emboss.
Technique: Smooth, Chisel hard, Chisel soft đều được sử dụng trong hiệu ứng Bevel and

Emboss
Softer và Precise áp dụng cho inner Glow và outer Glow.

Smooth: Làm mờ cạnh cho mềm và mịn hơn.
Chisel hard: Sử dụng kỹ thuật đo đạc, tính toán để tạo ra độ chi tiết cho hiệu ứng cao

hơn Smooth.
Chisel soft: Sử dụng kỹ thuật đo đạc, tính toán tương tự Chisel Hard nhưng không chính

xác bằng.
Tuy nhiên phạm vi áp dụng lớn hơn Chisel Hard.

Softer: Áp dụng hiệu ứng nhòe lên hình ảnh cho dù cạnh của nó mềm hay cứng.
Ở kích thước lớn hơn, Softer không giữ được mức độ chi tiết.

Precise: Sử dụng kĩ thuật đo đạc, tính toán để tạo ra ánh sáng cho hình ảnh.
Texture: Áp chất liệu lên cho hình ảnh.

2.4 Tạo được mặt nạ lớp
Layer mask là MẶT NẠ giúp che phủ layer của bạn. Có nhiều loại mặt nạ với độ dày,

mỏng  khác nhau. Trên khung làm việc Layer mask chỉ hiển thị hai màu duy nhất là trắng
và đen. Với mức độ đen càng đậm thì độ che phủ của layer mask càng cao, điều đó đồng
nghĩa với việc layer đó sẽ  hiển thị càng nhạt.
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Mặt nạ của Layer mask là phần rất quan trọng trong Photoshop vì những lý do sau:
Là công cụ để tạo vùng chọn (selection) có thể thay dễ dàng thay đổi hình dạng.

Mặc định những phép hiệu chỉnh Adjustment Layer sẽ luôn có Layer Mask đi kèm cho
phép bạn chỉ định vùng áp dụng phép hiệu chỉnh theo đúng ý bạn mong muốn.

Có thể dễ dàng dùng hình shape ở dạng vector, hoặc text để tạo ra mask.
Mask chỉ che chắn layer không tác động đến cấu trúc layer. Ví dụ như bạn dùng cục tẩy

Eraser xóa một phần nào đó của Layer, sau khi bạn save và thoát khỏa photoshop coi như
bạn mất hoàn toàn phần layer đã xóa. Đối với mask thì nó chỉ che chắn mà không hề tác
động đến cấu trúc các điểm ảnh trên layer.

Hình 3.24 Layer Mark
Layer là tập hợp những vùng hình, ảnh. Một layer có thể tập hợp một hoặc nhiều vùng

hình,  ảnh.  Cũng  có  thể  một  layer  không  có  hình  ảnh  nào  bên  trong.
Hình minh họa là 2 layer, layer màu xanh lục nằm dưới và layer màu vàng nằm trên. Layer
nào nằm phía trên sẽ che layer nằm phía dưới. Khi áp dụng mask vào layer màu vàng, mặc
định là mask xuất là ô màu trắng, khi tô màu đen lên một vùng nào đó của Mask thì giống
như ta đang xóa vùng đó và có thể nhìn xuyên qua (không được che chắn). Bạn đang sử
dụng Adjustment Layer thì phần tô màu đen xem như không có áp dụng phép hiệu chỉnh.
Nếu tô màu xám, mức độ “che chắn” theo mức độ xám (ví dụ màu xám 128 thì che chắn
50%)
2.4.1 Cách tạo Layer Mask :

Bằng cách nhấn vào biểu tượng “Add layer mask” ở bảng layers, ta tạo ra được Layer
Mask.
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Hình 3.25 Tạo Layer mark
2.4.2 Cách tạo ra Layer Mask “âm bản” (mask màu đen)

Giữ phím Alt  và click vào biểu tượng “Add layer mask” ở bảng layers,  ta tạo ra
được Layer Mask “âm bản” (mask màu đen)

Bạn cũng có thể đổi từ Mask màu trắng sang đen bằng cách nhấn tổ hợp phím Ctrl + I.
Và ngược lại.

         
Hình 3.26 Tạo ra Layer Mask âm bản

2.4.3 Liên kết Layer và Mask:
Layer và Mask là 2 phần độc lập nhau. Mặc định nó sẽ được liên kết bặng biểu tượng

linked nằm giữa Layer và Mask. Nếu Layer được di chuyển nó sẽ kéo Mask di chuyển
theo.

Bằng cách click vào biểu tượng linked nằm giữa Layer và Mask. Ta có thể tạm thời
ngưng kích hoạt liên kết. Ta có thể di chuyển Mask và Layer độc lập nhau.

Hình 3.27 Liên kết Layer và Mask
2.4.4 Tạm thời không sử dụng Mask:

Để tạm thời “disable” Mask ta giữ phím shift và click vào Mask. Để kích hoạt trở lại ta
cũng làm tương tự.
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Hình 3.27 không sử dụng Mask
2.4.5 Xóa Mask:

Đơn giản chỉ click vào Mask và kéo vào thùng rác . Một hợp thoại xuất hiện cho các
quyền lựa chọn:

Nếu chọn Apply: Mask sẽ được xóa và layer sẽ thay đổi như hiển thị hiện hành.
Nếu chọn Discard (phiên bản photoshop mới là Delete): Mask sẽ được xóa và layer sẽ

hiển thị như lúc chưa áp dụng Mask.
Nếu chọn Cancel: Bỏ qua tác hoạt xóa Mask.

Hình 3.28 Xóa Mask
2.4.6 Hiển thị Mask:

Mask nằm cạnh layer như 1 “thumnail” đôi khi quá nhỏ để xem. Muốn hiển thị Mask,
giữ phím Alt + double Click vào Mask.
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Hình 3.29 Hiển thị Mask
2.4.7 Mức độ đậm đặc (density) của Mask:

Nếu muốn thay đổi độ đậm đặc (density) của Mask, thay vì tô màu đen ta có thể tô màu
xám. Tùy theo mức độ xám ta được mức độ đậm đặc của Là. Ví dụ nếu tô màu xám 50%
(128), ta sẽ được Mask che chắn 50% và trong suốt 50%.

Hình 3.29 Hiển thị Mask
2.4.8 Vector Mask:

Mask cũng có thể là các dạng hình học được tạo ra từ các công cụ tạo Shape bằng cách
vào Layer / Add Vector Masks / Reveal(hide) All.

 
Hình 3.30 Vector Mask

2.4.9 Sử dụng nhiều Mask:
Ta có thể áp dụng nhiều Mask cùng lúc. Tuy nhiên trong mỗi một thời điểm chỉ có thể

sử dụng 1 Mask mà thôi Mask nào ở phía trước được áp dụng mask ở phía sau muốn được
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áp dụng phải “disable” Mask ở trước . Tuy nhiên nếu có Vector Mask thì Vector Mask sẽ
được ưu tiên áp dụng.

Vi dụ minh họa sử dụng Mask và Vector Mask cùng lúc

Hình 3.31 Minh họa sử dụng Mask và Vector Mask cùng lúc
Ví dụ minh họa Disable Mask phía trước và phía sau

Hình 3.32 Minh họa Disable Mask phía trước và phía sau
2.4.10 Để kết hợp nhiều Mask:
Muốn sử dụng nhiều Mask (không có Vector Mask) thì ta dùng Layer Group. Chọn Layer
nhấn tổ hợp Ctrl+G để tạo Layer Group sau đó áp dụng Mask lên Group.

Hình 3.33 Minh họa kết hợp nhiều Mask
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2.5 Tạo nhóm xén 
2.5.1 Move Toolbox

Move  tool  được  sử  dụng  để  di  chuyển  các  điểm  ảnh  trên  màn  hình.  Bạn  có  thể
chuyển text, layer mask, layer bình thường, khu vực được lựa chọn. Các phím tắt cho công
cụ này là V, nhưng tạm thời truy cập vào nó trong khi có một số công cụ được lựa chọn chỉ
cần giữa Ctrl và di chuyển. Một khi bạn đã hoàn tất chuyển Ctrl và bạn sẽ có thể kiểm soát
được  các  công  cụ  của  bạn  trước  đó (các  công  cụ  mà  bạn  có  trước  khi  ấn  Ctrl). 
2.5.2 Rectangular Marquee, Elliptical Marquee, Single Row Marquee Tool và Single
Column Marquee Tool

Rectangular Marquee Tool được sử dụng cho việc lựa chọn hình chữ nhật và cấc công
cụ Elliptical Marquee được sử dụng cho việc lựa chọn hình elip. Nếu bạn muốn tạo ra vòng
tròn hoặc hình vuông giữ phím Shift trong khi kéo các công cụ tương ứng. Nếu bạn muốn
di chuyển vùng chọn khi tạo ra nó, giữ Space. Để thêm vào một báo lựa chọn hiện có và
giữ phím Shift trước khi sử dụng công cụ này – bạn sẽ thấy dấu hiệu bên cạnh con trỏ công
cụ. Nếu sau khi bạn thấy dấu hiệu cạnh con trỏ bạn phát hành và nhấn phím Shift bạn sẽ tạo
ra vòng tròn hoàn hảo hoặc hình vuông. Giữ phím Alt trước khi kéo sẽ trừ từ một lựa chọn
hiện có và giữ phím Alt và Shift sẽ giao nhau với một lựa chọn hiện có. Nếu bạn đang trừ
từ một lựa chọn một dấu trừ nhỏ sẽ xuất hiện ở phía bên phải của biểu tượng của công cụ
và một chút X cho giao nhau.

Đối với việc thêm những shortcut, loại bỏ và giao nhau với các lựa chọn hiện tại áp dụng
cho hầu như tất cả các công cụ lựa chọn vì vậy tôi sẽ không được lặp lại chúng nữa.
Tôi gần như không bao giờ sử dụng các công cụ Single Row Marquee hoặc Single Column
Marquee Tool nhưng có lẽ nếu bạn là một nhà thiết kế web, bạn sẽ có một sử dụng chúng.

Hình 3.34 Các công cụ nhóm xén ảnh
2.5.3 Lasso Tool, Polygonal Lasso Tool và Magnetic Lasso Tool

Lasso Tool được sử dụng cho việc lựa chọn tự do. Không phải là một công cụ chính xác
và hầu như không mấy khi sử dụng nhưng nó có một vài điểm hấp dẫn với từng trường
hợp.

Công cụ Polygonal Lasso là một công cụ lựa chọn chính xác hơn, cho phép bạn tạo ra
một lựa chọn bởi các đường thẳng. Có hạn chế sử dụng đối tượng rectangular. Nếu bạn
đang sử dụng công cụ Lasso Tool, bạn có thể tạm thời truy cập Polygonal Lasso Tool bằng
cách giữ phím Alt.

Magnetic Lasso có độ chính xác của tất cả các công cụ trong nhóm. Nó hoạt động bằng
cách chụp cá cạnh của đối tượng, bạn chỉ cần click một lần trên cạnh xung quanh đối tượng
và để ý rằng Magnetic Lasso Tool sẽ “snaps” các cạnh.
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Hình 3.34.1 Các công cụ nhóm xén ảnh
Bạn có thể xem hình dưới, chúng tôi lựa chọn công cụ Magnetic Lasso Tool. Lựa chọn

chiếc ô màu xanh, hãy dùng công cụ này khi bạn là người mới.

Hình 3.34.2 Minh họa công cụ nhóm xén ảnh
2.5.4 Quick Selection Tool và Magic Wand Tool

Magic Wand Tool là một công cụ ít tốt đẹp mà có các công dụng của nó theo thời gian.
Nếu bạn nhấp vào một nơi nào đó trong hình ảnh đó sẽ chọn tất cả các điểm ảnh trong đó
khu vực có mức độ sáng gần với mức độ sáng của các cấp độ, bạn nhấp vào. Bạn có thể
thiết lập này bằng cách nhập một giá trị vào ô Tolerance (các Tolerance nằm trong các
công cụ tùy chọn thanh nằm phía trên cùng của màn hình).

Hình 3.34.3 Các công cụ nhóm xén ảnh
Hình ảnh dưới đây được thiết lập Tolerance tới 2 và ấn vào trên tường trong bức ảnh.

Chú ý những hình được tạo này và tránh lựa chọn không đúng.

Hình 3.34.4 Minh họa công cụ nhóm xén ảnh
Sau khi thay đổi Tolerance tới 20 và ấn vào vị trí tường tương tự.

Hình 3.34.5 Minh họa công cụ nhóm xén ảnh
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Trong công cụ option bar là một checkbox cho phép bạn leaj chọn khi vực không liền kề
nhau vì vậy nếu tôi bấm lại vào cùng một chỗ trên tường sau khi loại bỏ các kiểm tra từ các
hộp kiểm Contiguous, chọn cả hai bức tường bên trái và bên phải và thường mỗi điểm ảnh
với độ sáng gần khu vực nhấp.

Hình 3.34.6 Minh họa công cụ nhóm xén ảnh
2.5.5 Crop Tool, Slice Tool và Slice Select Tool

Crop Tool cho phép bạn cắt hình ảnh của bạn để kích thước mong muốn. Click, kéo,
nhấn Enter và bạn chỉ cần cắt hình ảnh của bạn. Thu hoạch tốt nhất là thực hiện vào cuối
của quá trình chỉnh sửa.

Công cụ Slice và Slice Select Tool là chủ yếu cho các nhà thiết kế web và có rất ít sử
dụng cho mục đích sử dụng thường xuyên. Kéo với công cụ Slice và tạo hình chữ nhật
(thường là các trang web layout). Sau khi bạn đã thực hiện xong bạn chọn Save for Web &
Devices từ menu File và chọn một thư mục. Quá trình này sẽ tiết kiệm cho mỗi phần cắt lát
như là một hình ảnh riêng biệt từ đó cho phép bạn nhanh chóng sử dụng các hình ảnh để
tạo trang web.

Hình 3.34.7 Công cụ nhóm xén ảnh
2.5.6 Eyedropper Tool, Color Sampler Tool, Ruler Tool, Note Tool, 123 Count Tool

Nếu bạn đang làm điều chỉnh màu trong hình ảnh sau đó các công cụ Eyedropper là
người bạn tốt nhất của bạn. Để sử dụng nó đúng cách đầu tiên thiết lập kích thước mẫu
trong thanh tùy chọn (Option Bar Tôi tiếp tục nói chuyện về nằm ngay dưới Menus) đến 3
× 3 hoặc thậm chí tốt hơn 5 × 5.

Hình 3.35 Các công cụ chỉnh màu 
Di chuột công cụ Eyedropper trong ảnh và chú ý cách thay đổi các giá trị RGB. Nếu bạn

nhấp vào bất cứ nơi nào với công cụ này vào hình ảnh bạn sẽ thiết lập màu Foreground
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thành  màu  dưới Eyedropper  Cursor.  Một  cách  nhanh  chóng  để  truy  cập  các  công  cụ
Eyedropper trong khi có những công cụ Brush Tool chọn nó là nhấn phím Alt.

Giữ phím Shift và nhấp chuột trái trong khi sử dụng các công cụ Eyedropper để truy cập
Color Sampler Tool và tạo ra một mẫu màu mới (bạn có thể có tối đa 4 người lấy mẫu
màu). Bạn có thể nhìn thấy trong hình dưới đây, nơi lấy mẫu màu sắc của tôi và các giá trị
RGB trong khu vực tôi đã lấy mẫu từ những gì đang có. Thông tin này rất hữu ích khi bạn
làm điều chỉnh màu sắc hoặc bạn muốn biết giá trị của một khu vực cụ thể là gì. Thậm chí
tốt hơn, bạn có thể thay đổi chế độ để Lab, CMYK, HSB hoặc chế độ lập dị khác. Tôi nhớ
rằng tôi sử dụng công cụ này rất nhiều khi tôi lần đầu tiên được học về Photoshop để xem
cách khác nhau và điều chỉnh chế độ pha trộn ảnh hưởng đến các giá trị điểm ảnh.

Hình 3.35.1 Minh họa các công cụ chỉnh màu 
Công cụ Ruler là để đo kích thước thực tế trên màn hình. Không nhiều mục đích sử dụng

cho công cụ này (có lẽ nếu bạn là một nhà thiết kế web), nhưng nó có một tính năng rất
hay. Trong thanh tùy chọn có một nút gọi là thẳng. Dưới đây là làm thế nào để sử dụng nó.
Chú ý rằng trong hình dưới đây, mức độ mặt đất là không ngang. Nó trông giống như ngôi
nhà đang rơi về phía bên trái.

Hình 3.35.2 Minh họa các công cụ chỉnh màu
Để khắc phục điều này, chọn công cụ Ruler đó, và kéo nơi đường chân trời là trong hình
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Hình 3.35.3 Minh họa các công cụ chỉnh màu

Bấm vào Straighten và voila, đã thẳng đường chân trời. Một chút của việc cắt xén xảy ra
ở các cạnh, nhưng đó là một thương mại tốt tắt cho một hình ảnh thẳng.

Hình 3.35.4 Minh họa các công cụ chỉnh màu
2.6 Làm phẳng file ảnh

Khi chụp ảnh ở tiêu cự ngắn với cự ly gần, nhất là với các ống kính kém chất lượng, ảnh
thường bị phình cong ở mép ảnh, hình ảnh bị ưỡn lồi ra hoặc lõm vào (distortion) làm ảnh
rất xấu (cầu sai). Để khắc phục điều này, đơn giản nhất, nhưng cũng tốn kém nhất là thay
ống kính khác có độ méo thấp hơn hoặc triệt tiêu hiện tượng méo hình.
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Hình 3.36 Minh họa làm phẳng ảnh
Tuy nhiên, bạn có thể khắc phụ hiện tượng này bằng cách sử dụng các công cụ sửa méo

hình của các phần mềm chỉnh sửa ảnh số.  Sau đây là cách sử dụng công cụ này của
Photoshop (Minh họa sử dụng Photoshop CS2). Cách làm như sau:

1. Mở ảnh bằng Photoshop
2. Từ thanh công cụ lần lượt vào các mục sau: Filter > Distort > Lens correction (xem

hình). Trước phiên bản CS2, vào Filter > Distort > Spherze. Với các phiên bản CS mới của
Photoshop, menu này được đặt ở ngay dưới Filter: Filter > Lens Correction (hoặc nhấn
Shift+Ctrl+R với Windows).

Hình 3.36.1 Minh họa làm phẳng ảnh
Hình 3.36.1: Vào công cụ chỉnh sửa sai lệch do ống kính gây ra
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Trên màn hình công cụ này, bạn sẽ thấy nhiều tiện ích của Photoshop bao gồm (xem
hình 2):

Hình 3.36.2 Minh họa làm phẳng ảnh
Hình 3.36.2: Cửa sổ công cụ chỉnh sửa sai lệch ống kính và các tiện ích
Remove distortion: Triệt tiêu méo hình. Kéo thanh trượt sang trái hoặc phải và quan sát

hiệu ứng để điều chỉnh độ méo của ảnh. Thay vì kéo thanh trượt, bạn có thể nhập số vào ô
bên cạnh để tăng độ chính xác. Lưu ý: Cần bật nút Preview (ở giữa, phía dưới cửa sổ).

Chromatic aberration: Chỉnh sửa độ sắc sai. Cách làm cũng như trên.
Vignette: Chỉnh sửa hiện tượng ảnh bị tối ở góc và mép ảnh. Bạn có thể chỉnh sửa

Amount (lượng ánh sáng) cho sáng lên (lighten) hoặc cho tối đi (darken). Bạn cũng có thể
đặt độ sáng trung bình của ảnh bằng cách kéo sang trái (giảm) hoặc sáng phải (tăng) thanh
Midpoint.

Transform: Chỉnh sửa độ vếch góc của ảnh. Với tiện ích này, bạn có thể chỉnh sửa độ
vếch góc của ảnh theo chiều dọc (vertical) và theo chiều ngang (horizontal).
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Lưu ý: Bạn cần chọn các chế độ mép ảnh (Edge) khác nhau để tạo các hiệu ứng cuối
cùng khác nhau cho mép ảnh khi công cụ xử lý hình ảnh: Transparency (trong suốt), Edge
extention (mở rộng và bù vào mép ảnh), Background color (thêm màu nền).

Ngoài ra, do độ méo ở giữa và mép của ảnh thường khác nhau, để chỉnh sửa cho tất cả
các khu vực trên ảnh không còn méo, bạn cần nhân ảnh thành nhiều lớp (layer), rồi ở mỗi
lớp chỉnh sửa độ méo khác nhau rồi trộn lấy từng phần ở giữa và mép ảnh với nhau để triệt
tiêu hiện tượng méo trên toàn diện tích của ảnh.

Dưới đây là minh họa hiệu ứng sử dụng Remove distortion

Hình 3.36.3 Minh họa làm phẳng ảnh trước khi remove distortion

Hình 3.36.4 Minh họa làm phẳng ảnh sau khi remove distortion
Bài tập: Tạo thuần thục các layer, và chỉnh sửa những ảnh mà bạn thấy khiếm khuyết. 
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BÀI 4. CÁC CÁCH XỬ LÝ ẢNH
Giới thiệu

Trong bài này giới thiệu cho học sinh cách xử lý ảnh làm sao thực hiện các góc độ và
tinh chỉnh màu sắc hình ảnh.
1. Mục tiêu:

Trình bày được cách xử lý các hình ảnh
Thực hiện được các góc độ cho hình ảnh
Thực hiện được sự tinh chỉnh màu sắc cho hình ảnh.
Cẩn thận, thao tác nhanh chuẩn xác, tự giác trong học tập

2. Nội dung bài học
2.1 Các phép quay ảnh
Xoay hình trong photoshop là một trong những yêu cầu tất yếu. Vậy có những cách thức
xoay lật, và đảo ngược hình ảnh trong photoshop nào? Trong bài viết ngày tôi sẽ cùng các
bạn đi tìm hiểu về những cách xoay lật, và quản lý hình ảnh trong photoshop
2.1.1 Xoay hình trong photoshop

Xoay hình trong photoshop có rất nhiều cách thức thực hiện khác nhau. Mỗi cách có
những ưu nhược điểm và cách thực hiện khác nhau. Ở đây Tự Học Đồ Họa sẽ hướng dẫn
các bạn 3 cách Xoay hình trong photoshop là. Xoay toàn bộ vùng làm việc và xoay layer,
và xoay 1 phần bức ảnh.

Hình 4.1 Minh họa xoay hình
Tuy nhiên trong cả 3 phương pháp đều có những thông số, và thuật ngữ giống nhau bạn

cần lưu ý như sau:
Rotate 180: Cho phép bạn Xoay ảnh 180 độ
Rotate 90:  Thực hiện Xoay ảnh 90 độ ngược chiều kim đồng hồ
Rotate 90:   Thực hiện Xoay ảnh 90 theo chiều kim đồng hồ
Flip Horizontal:  Lật ảnh theo chiều ngang
Flip Vertical:  Lật ảnh theo chiều dọc.

Sau khi ghi nhớ các thuật ngữ trên bạn làm theo các cách làm sau.
2.1.1.1 Cách xoay, lật đảo ngược toàn cảnh.

Đây là phương pháp Xoay hình trong photoshop áp dụng cho các trường hợp. Bạn chỉ
muốn xoay, lật 1 bức hình duy  nhất từ máy tính. Hoặc thực hiện xoay toàn bộ filet thiết kế
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bằng photoshop của bạn (tức là tất cả các layer có trong photoshop). Bạn thực hiện như
sau:

Bước 1: Thả ảnh vào photoshop hoặc lựa chọn file làm việc mà bạn muốn Xoay hình. từ
thanh menu > image > image rotation

Bước 2: Từ thanh thả xuống bạn lựa chọn chế độ mà mình muốn lật ảnh. Lưu ý rằng
trong thanh thả xuống bạn có 1 thuộc tính là arbitrary. Đây là thuộc tính cho phép bạn tùy
chọn góc xoay hình của bạn.
2.1.1.2 Xoay hình trong photoshop là layer (lớp đối tượng)

Phương pháp Xoay hình trong photoshop áp dụng cho các trường hợp. Bạn muốn xoay
lật 1 đối tượng bất kì trong file làm việc của mình. Có nghĩa là trong file làm việc của bạn
có rất nhiều các Layer   khác nhau và bạn chỉ muốn xoay 1 trong số đó.

Bạn thực hiện như sau:
Bước 1: Lựa chon layer chứa đối tượng mà bạn xuốn xoay, lật hình.
Bước 2: Để lật được hình bạn cần lựa chọn chế độ Free transform. Bạn có thể ấn tổ hợp

phím Ctrl + T Hoặc từ thanh Menu > edit > Free transform.  Lúc này 1 khung hiện ra bao
lấy đối tượng bạn cần xoay. Bạn sẽ có 2 lựa chọn, là Xoay hình trong photoshop một cách
tự do. và xoay theo thông số có sẵn

Bước 3: Lựa chọn chế độ Xoay hình trong photoshop; xoay hình với 1 góc tự do.  Sau
khi áp dụng chế độ free transform cho layer. bạn sẽ thấy 1 khung bao quanh đối tượng cần
xoay. Lúc này bạn đặt chuột của mình vào 1 trong 4 góc của khung hình vuông.

Lưu ý: bạn cần di chuyển chuột nhẹ 1 chút quanh điểm góc. Sao cho xuất hiện 1 mũi
tên 2 chiều cong. Lúc này bạn giữ chuột trái và xoay hình trong photoshop một cách tự do.

Xoay hình với thông số mặc định: Sau khi áp dụng chế độ free transform cho layer.
Bạn click phải chuột vào vùng làm việc của free transform. 1 bảng quản lý thuộc tính sẽ
hiện ra. Tiếp theo bạn lựa chọn cho mình 1 chế độ phù hợp.
2.1.1.3 xoay 1 phần bức ảnh trong photoshop

xoay 1 phần bức ảnh. Là một trong những kĩ thuật xoay hình trong photoshop phổ biến.
thông thường cách này áp dụng cho những trường hợp đặc biệt. Khi mà bạn chỉ muốn xoay
1 phần rất nhỏ của một đối tượng trong phần hình ảnh của mình. Về thủ thuật xoay 1 phần
bức ảnh trong photoshop được áp dụng tương tự như các phương pháp trên. Nhưng sự khác
biệt là bạn cần phải lựa chọn được phần hình ảnh mà bạn muốn xoay. Sau đó áp dụng
phương pháp xoay hình nêu ở mục 1.2

Bước 1: bạn lựa chọn 1 công cụ tạo vùng chọn bất kì. ở đây tôi chọn công cụ rectangular
tool tạo ra vùng chọn bao lấy đối tượng cần xoay.

Bước  2:  Bạn  có  thể  ấn  tổ  hợp  phím Ctrl+T Hoặc  từ  thanh Menu>Edit>Free
transform.  và tiến hành thực hiện các bước tương tự như đối với xoay 1 đối tượng là layer
2.2 Biến đổi hình ảnh

Photoshop giúp người dùng đổi màu của chủ thể, đơn cử là thay đổi màu áo, màu tóc,
màu nước sơn,... mặc dù đây là một trong những thủ thuật cơ bản nhất của photoshop, tuy
nhiêu còn khá nhiều người dùng vẫn chưa biết cách thao tác nhanh để có được bức ảnh
thực nhất.
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Hình 4.2 Minh họa biến đổi hình ảnh
Dĩ nhiên, đây là bài viết hướng dẫn đổi màu của đối tượng bằng Photoshop, do đó yêu

cầu tối thiếu là máy tính bạn cần được cài đặt Adobe Photoshop. 
Thật ra có đến 3 cách giúp thay đổi màu sắc của đối tượng, tuy nhiên tại giáo trình này

sẽ hướng dẫn bạn cách thực hiện phương pháp thông dụng nhất, nhanh nhất.
Trong Photoshop có tính năng Replace Color, có thể hiểu rằng tính năng này giúp thay

đổi màu sắc của đối tượng trong bức hình, khi sử dụng Replace Color, tất cả những điểm có
màu giống nhau trong bức ảnh hoặc phần chọn sẽ được thay đổi thành một màu khác. 

Hình 4.2.1 Minh họa biến đổi hình ảnh
Bạn có thể chọn một vùng thay đổi màu sắc bằng công cụ Lasso từ Photoshop để việc

thay đổi màu sắc đối tượng không ảnh hưởng đến các vùng khác trên bức ảnh, chọn công
cụ Lasso như hình và khoanh vùng vị trí cần chỉnh sửa (Chọn sao cho vị trí xuất phát và kết
thúc khoanh vùng gặp nhau tại 1 điểm). 
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Hình 4.2.2 Minh họa biến đổi hình ảnh
Sau đó vào Image > Adjustments > Replace Color.

Hình 4.2.3 Minh họa biến đổi hình ảnh
Sau đó chọn mã màu mà bạn muốn thay đổi, để đơn giản hơn bạn chọn ống hút màu tại

khung tùy chọn Replace Color, ngay lập tức tại màn hình đen Selection sẽ xuất hiện chủ
thể bạn cần thay đổi. 

Hình 4.2.4 Minh họa biến đổi hình ảnh
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Ngoài ra, bạn có thể sử dụng đến 2 tùy chọn hút màu bên cạnh để tăng/giảm vùng chọn,
tính năng Fuzziness cũng khá hay, giúp điều chỉnh cường độ bao phủ của vùng chọn. 

Hue, Saturation hay Lightness sẽ giúp bạn thay đổi màu sắc, ánh sáng cũng như độ
bảo hóa của đối tượng đã chọn. Bạn có thể căn chỉnh chúng để thay đổi màu sắc sao cho
vừa mắt. Cuối cùng là nhấn nút OK để lưu thay đổi.

Hình 4.2.5 Minh họa biến đổi hình ảnh
Để bỏ vùng chọn trước khi lưu ảnh, bạn chọn Ctrl+D. Hi vọng với cách thay đổi màu

sắc trên sẽ hỗ trợ tốt nhất cho bạn trong quá trình xử lý hình ảnh bằng Photoshop.
2.3 Kênh màu và hiệu chỉnh kênh màu

Bất kể bạn học cái gì thì chúng ta cũng phải đi từ những thứ cơ bản nhất để tạo nền tảng
cho mọi thứ sau này. Khi các bạn đã có một kiến thức cơ sở vững chắc thì bạn sẽ phát triển
một cách nhanh chóng. Vì vậy việc học các nguyên tắc cơ bản là thực sự quan trọng. Thời
gian đầu bạn hãy dành thời gian tìm hiểu các công cụ và tính năng trong   Photoshop. Sau
khi bạn đã nắm vững các nguyên tắc cơ bản rồi thì chúng ta sẽ bắt đầu đi vào các kỹ thuật
xử lý phức tạp hơn.
Thông thường mỗi ảnh màu được tổng hợp bởi tập hợp một số màu chuẩn

Grayscale: Tập bởi 2 màu đen và trắng
RGB: Tập hợp bởi 3 màu RGB (tương ứng với 3 kênh màu chuẩn)
CMYK: Tập hợp bởi 4 màu (tương ứng với 4 kênh màu chuẩn)
Multiple channel: Chế  độ  ảnh đa  kênh  mầu (cho phép người sử dụng tạo thêm một số

không giới hạn kênh màu mới)
Ta có thể sử dụng phương thức tăng hoặc giảm kênh màu đồng thời hiệu chỉnh  chi tiết 

từng kênh  để  có  được một  ảnh màu chuẩn (có thể dung phương pháp này để phục chế
màu ảnh)
2.3.1 Thao tác cơ bản trên kênh màu

 Mở File ảnh gốc
Chọn Windows->Show Channel (hiện hộp thoại  Channel liệt  kê  toàn bộ các kênh màu

có trong ảnh)
Bật hoặc tắt một kênh màu

Bấm chuột vào biểu tượng  Indicates Channel Visibility (biểu tượng mắt)
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Thêm một kênh màu mới (áp dụng cho toàn ảnh) Bấm chọn Create New Channel trên
hộp Channel

Loại bỏ một kênh màu
Bấm phải chuột vào kênh màu cần loại bỏ và chọn Delete Channel

Copy kênh màu
Bấm  phải  chuột  vào  kênh  màu  cần  Copy,  chọn  Duplicate  Channel

(hiện hộp thoại)
As: Gõ vào tên kênh mới
Document: Chọn File lưu trữ kênh (thường đặt trực tiếp trên File hiện hành)
Bấm chọn OK

Đặt lại thuộc tính cho một kênh
Nháykép chuột vào kênh  màu cần hiệu chỉnh, xuất hiện hộp thoại cho các hiệu

chỉnh chi tiết:
Name: Tên của kênh hiện hành

Chú ý:
Color Indicate: Lựa chọn hiệu ứng màu của kênh  đối với toàn ảnh
Color: Bấm chọn màu và thay đổi áp lực của màu trênkênh (Opacity)
Trong phần Color Indicate cho ba lựa chọn:

Masked Areas: Áp dụng kênh như một vùng chọn ảnh
Selected Areas: Chỉ áp dụngcho một vùng  chọn trên kênh mới tạo
Spot Color: Áp  dụng hiệu chỉnh  màu cho  toàn ảnh (không có khả năng phục

hồi phương thức khác)
Khi cần hiệu  chỉnh màu cho ảnh bằng phương pháp hiệu  chỉnh kênh  ta nên  lựa

chọn trước vùng  ảnh và lựa chọn Selected Areas (Channel Option)
2.3.2 Tạo kênh màu áp dụng cho một vùng ảnh

T o kênh trên vùng ch n nhạ ọ ả
Lựa chọn vùng ảnh cần hiệu chỉnh màu
Bấm chọn Save Selection As Channel (trong hộp Channel)
Nháykép chuột vào kênh màu vừa tạo:

- Channel              Gõ vào tên cho kênh
- Color Indicates    Lựa chọn Selected Areas
- Color                  Lựa chọn màu và thay đổi lại áp lực (Opacity)

Chuy n kênh màu thành vùng ch n:ể ọ
Bấm chọn kênh màu tương ứng
Bấm chọn biểu tượng Load Channel As A Selection (ta thu được một biên chọn ứng với

áp dụngmàu của kênh)
Ghi  chú:  Ngoài  phương  thức  đổ  màu  cho  ảnh  đã  học  ở  phần  trước,  ta  có  thể

Áp dụng phương thức thêm bớt và hiệu chỉnh kênh màu để có được ảnh hiệu chỉnh màu
hoàn thiện.

Bài tập: Thực hiện đổi phong nền bầu trời và áo của các người đang mặc trong hình thực
hành thành màu mà bạn thích.
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BÀI 5. TEXT VÀ FILTER
Giới thiệu

Trong bài này giới thiệu cho học sinh biết nhập văn bản bằng tiếng việt, tạo hiệu ứng
cho văn bản vừa nhập.
1. Mục tiêu:

Định nghĩa về Text và Filter
Thao tác nhập được text vào hình ảnh bằng tiếng Việt
Sử dụng thành thạo các bộ lọc của photoshop
Tạo được hiệu ứng cho text.
Có tin thần học tập nghiêm túc, rèn luyện tính tỉ mỉ

2. Nội dung bài học
2.1 Text

Về căn bản, Type Tool là một công cụ dùng để tạo ra những vector mang hình dáng của
chữ cái và các ký hiệu của một typeface. Trên thanh công cụ, icon của Type Tool là một
chữ T, phím tắt cũng là (T). Nếu bạn nhấn Shift + T nhiều lần, công cụ này sẽ thay đổi lần
lượt thành những công cụ khác trong nhóm Type Tool, chúng bao gồm:

 Horizontal Type Tool: công cụ cho phép bạn tạo ra những dòng text nằm ngang.
 Vertical Type Tool: công cụ cho phép bạn tạo ra những văn bản theo chiều dọc, loại

này thường dùng để gõ những đoạn text tiếng Hoa hoặc Nhật.
 Horizontal Type Mask Tool, Vertical Type Mask Tool: tương tự như hai công cụ

trên, nhưng thay vì tạo ra text, hai công cụ này tạo ra những vùng chọn Quick Mask với
hình dạng là những chữ cái. Chúng ta sẽ nói riêng về vấn đề này.

 
Hình 5.1 Công cụ Type trong Photoshop

Một khi bạn chọn công cụ Type Tool, con trỏ sẽ trở thành dạng như khi bạn dùng Word,
điều đó có nghĩa là bạn đã có thể bắt đầu việc nhập text của mình.

Tạo ra một text layer
Có hai cách để tạo ra một text layer, đó là theo dòng và theo đoạn.
Với loại text theo dòng, bạn sẽ tạo ra một text layer chỉ có một dòng, nếu muốn thêm

một dòng khác bạn phải dùng phím Enter. Chọn công cụ type bạn cần, sau đó click chuột
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lên một vị trí bất kỳ trong file bạn đang làm việc và bắt đầu việc nhập text. Sau khi hoàn
thành, để thoát ra khỏi chế độ nhập, bạn có thể gõ Enter bên bàn phím số, click chuột lên
tên text layer hoặc Ctrl + Enter.

Hình 5.1 Minh họa công cụ Type trong Photoshop
Với loại text theo đoạn, sau khi tạo ra, text của bạn chỉ nằm trong một khung chứa văn

bản, phần vượt quá sẽ không được hiển thị. Cách này rất thường được sử dụng khi bạn
đang thiết kế cho việc in ấn và thiết kế web. Để tạo ra khung chứa text, bạn chỉ việc nhấn
giữ chuột trái và rê chuột cho đến khi có được kích thước theo ý muốn.

 
Hình 5.1.1 Minh họa công cụ Type trong Photoshop
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Hình 5.1.2 Minh họa công cụ Type trong Photoshop
Ngoài ra, bạn cũng đừng lo khi còn những layer bên dưới, khác với một số công cụ

khác, Type Tool tự động tạo ra một layer mới để chứa text. Bạn cũng có thể chuyển đổi qua
lại giữa hai chế độ theo dòng và theo đoạn bằng cách chọn phần text mong muốn, sau đó
vào Layer > Type > Convert to Paragraph Text / Convert to Point Text.

Thay đổi kích thước và hình dạng
Bạn có thể dễ dàng biến đổi kích thước và hình dạng của một text layer giống như các

layer  khác.  Chọn Move  Tool (V),  click  chọn  layer  text, Ctrl+T và  bắt  đầu  những  thao
tác tùy chỉnh chúng. Tuy nhiên việc này không được khuyến khích vì như thế bạn sẽ làm
biến đổi hình dạng của những chữ cái và ký hiệu.

 Đối  với  khung  bao  text  ở  chế  độ  nhập  text  theo  đoạn,  vẫn  với Move  Tool,  bạn
nhấn Ctrl+T rồi trỏ chuột đến các nút của khung bao vào thực hiện việc thay đổi hình dạng
của khung bao này. Nhấn thêm phím Shift, khung bao sẽ giữ nguyên tỉ lệ ban đầu, nhấn
Ctrl thì bạn có thể biến dạng các cạnh khung text một cách tùy thích. Trong quá trình thay
đổi khung text, các ký tự trong đoạn text cũng tự động thay đổi theo đúng tỉ lệ so với khung
bao.

Hình 5.1.3 Minh họa công cụ Type trong Photoshop
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Hình 5.1.4 Minh họa công cụ Type trong Photoshop

Hình 5.1.5 Minh họa công cụ Type trong Photoshop
 Bảng Character

   
 Sau khi thực hiện xong quá trình nhập text, bạn có thể sẽ muốn thay đổi thuộc tính của

đoạn text này, chẳng hạn như thay đổi font chữ, màu sắc,… Tất cả những việc này được
thực hiện trên bảng Character. Bạn có thể tìm thấy bảng này bằng cách vào Window >
Character. Trong bảng này bạn có thể tùy chỉnh những thông số sau:
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 Kerning và Tracking 
 Kerning (khoảng cách giữa hai chữ cái) giúp bạn thay đổi khoảng cách giữa 2 chữ cái

cạnh nhau.
 Tracking (hiểu nôm na là khoảng cách tổng thể giữa tất cả các chữ cái với nhau) có

thể được chỉnh theo từng thông số có sẵn, mục này rất ít khi phải chỉnh vì mặc định các
font chữ đã đạt chuẩn.
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 Thay đổi kích cỡ chữ theo chiều ngang và chiều dọc
 Bạn có thể thay đổi độ cao và rộng của chữ bằng cách nhập vào thông số theo giá trị %.

Tuy nhiên như đã nói ở trên, cách này không được khuyến khích vì sẽ làm hỏng tỉ lệ của
những chữ cái được thiết kế từ trước.
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 Baseline Shift: một tùy chọn dùng để thay đổi vị trí của đường chân chữ, rất thích hợp cho
một số trường hợp bạn cần thay đổi vị trí chữ trong một dòng.
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 Faux Bold và Faux Italic: là một tùy chọn nhằm tạo ra dạng chữ Bold và Italic cho bất

kỳ typeface nào. Lưu ý là bạn nên phân biệt giữa typeface có thiết kế Bold, Italic riêng và
những typeface được áp dụng tùy chọn này. Khi dùng Faux Bold và Faux Italic sẽ làm hình

62



dạng chữ bị biến dạng khác với việc bạn viết kí tự đó bằng font chữ có in đậm hoặc in
nghiêng sẵn (bạn có thể thử dùng font chữ Myriad Pro, gõ chữ a với định dạng Italic và
thêm tùy chọn Faux Italic trong bảng Character để nhận ra sự khác biệt).

 
 Trang trí text: bạn có thể thay đổi đặc tính của đoạn text được chọn, chẳng hạn như biến
tất cả thành chữ in hoa, hoặc chữ in hoa nhỏ, chữ có gạch chân hoặc gạch ngang…
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 Anti-aliasing: một thuật ngữ khá quen thuộc trong những game sau này và thường

được gọi là khử răng cưa. Khi áp tính năng này lên text, nó sẽ khiến cho đường viền của
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các ký tự hòa vào background, lúc này các chữ cái sẽ trông mượt hơn. Có bốn tùy chọn là
Sharp,  Crisp,  Strong  và  Smooth,ngoài  ra  còn  có thêm một  tùy  chọn ban đầu là  None.
Thường bạn nên áp dụng tính năng này lên text, đặc biệt là những font Serif (có chân) để
chữ cái hiển thị tốt hơn.

Leading: Leading là khoảng cách giữa các dòng trong đoạn text, bạn có thể thay đổi
thông số này tùy thích ở bảng trong hình dưới đây. Thông số Auto sẽ khiến khoảng cách
này tự thay đổi theo cỡ chữ.
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2.2 Filter
2.2.1 Blur Filters
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Bạn sẽ không khó khi lờ mờ nhận biết được hiệu ứng của từng Filter qua tên của nó. Dĩ
nhiên, Blur Filter có tác dụng làm mờ ảnh. Trong Blur Filter còn có những menu phụ sau:

Blur
Blur More
Gaussian Blur
Motion Blur
Radial Blur
Smart Blur

Mở một file ảnh bất kỳ để chúng ta cùng khám phá hiệu ứng Blur. Nhớ rằng, nếu bạn
không thích một hiệu ứng nào đó, bạn có thể chọn Edit > Undo để bỏ hiệu ứng đó, hoặc bỏ
nó bằng cách dùng History Palette. Bạn có thể áp dùng các Filter chồng lên nhau. Tôi đã áp
dụng từng Filter vào hình gốc để bạn có thể nhận ra sự khác biệt giữa các Filter.

Chỉ có Blur và Blur More tác động trực tiếp đến ảnh mà không có hộp thoại điều khiển.
Cái này chỉ hữu dụng khi làm mềm tất cả hay một phần của anh. Tuy nhiên, nó không có
tuỳ biến lựa chọn. Bạn hãy thực hành với nó bằng cách áp dụng Blur, nếu vẫn không thấy
thay đổi gì hoặc ít thì làm thêm Blur lần nữa hoặc Blur More cho đến khi nào bạn ưng ý.
2.2.1.1 Gaussian Blur

Gaussian Blur cho phép bạn điều chỉnh độ Blur tốt hơn nhờ vào hộp thoại điều chỉnh.
Chú ý rằng bạn có thể điều chỉnh độ Radius bằng cách kéo sang trái hoặc phải, hoặc bạn có
thể điền giá trị số vào ô. Vùng xem trước rất hữu dụng cho người dùng, vì bạn có thể xem
trước những hiệu ứng sẽ như thế nào khi mình nhấn OK. Những phiên bản gần đây, hầu hết
các Filter đều có chế độ xem trước này. Nó tiết kiệm rất nhiều thời gian cho bạn khỏi phải
dùng undo hàng mấy lần mới được một lần ưng ý.
2.2.1.2 Motion Blur

Motion Blur filter tạo ra hiệu ứng "Ảo Ảnh" cho file hình của bạn. Đây là một hiệu ứng
tuyệt vời để áp dụng cho chữ hoặc sử dụng để tạo ra những hình Gif động.
Trong hộp thoại Motion Blur trường Distance định dạng độ mờ của hiệu ứng sẽ là bao
nhiêu hoặc hình gốc sẽ bị "di chuyển" ra xa bao nhiêu. Angle xác định chiều của hiệu ứng.
Để điều chỉnh, kéo biểu tượng bán kính của hình tròn hoặc điền giá trị chính xác vào ô. Với
ví dụ này tôi chọn giá trị Radius là 10 Pixel và Angle là 40.
2.2.1.3 Radial Blur

Hiệu ứng này không cho phép bạn xem trước, nhưng nó cho bạn thấy file hình sẽ bị tác
động như thế nào. Như cái tên của nó, nó làm cho hình của bạn bị làm mờ theo hình tròn.

Bạn có thể lựa chọn giữa Zoom và Spin Blur. Spin tạo  ra hiệu ứng xoay vàn và Zoom
tạo cho người xem cảm giác như đang bay vào hình ảnh.
2.2.1.4 Smart Blur

Hiệu ứng cuối cùng của Blur Filter là Smart Blur. Nó tìm đường biên màu của file ảnh
của bạn và làm mờ nó nhưng không ảnh hưởng đến phần còn lại của bức ảnh. Nếu bạn đặt
tuỳ biến Threshold thấp PTS sẽ tìm được nhiều đường biên hơn. Nếu bạn là người cẩn
thận, bạn nên để Threshold cao một chút. Radius kiểm soát chu vi bên ngoài kể từ đường
biên nơi mà Filter được áp dụng

Để có hiệu ứng hoàn toàn khác biệt, bạn có thể đổi Mode thành Edge Only trong menu
thả xuống, ở cuối cùng của hộp thoại Smart Blur. Kết quả nó sẽ cho bạn một hình chỉ có
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những đường biên, tương tự như một kiểu ảnh trắng đen hoạt hình vậy. Smart Blur cũng là
một bộ lọc khá tinh xảo của PTS.
2.2.2 Sharpen Filters

Sharpen filters làm việc với nguyên tắc ngược lại của Blur. Nhưng bạn không thể Blur
một hình rồi lại Sharpen nó, vì nó không hoàn toàn là làm điều ngược lại với Blur. Nó có
tác dụng chính là mang lại độ tương phản của file hình.

Bạn hãy mở một file ảnh và áp dụng hiệu ứng Sharpen xem. Filter > Sharpen > Sharpen.
Bạn cũng hay thử luôn cả Sharpen Edge và những Filter khác để biết thêm. Những hiệu
ứng này rất tuyệt khi dùng để điều chỉnh những tấm hình nằm ngoài tiêu cự (hình bị nhoè)
hoặc hình Scan. Nhưng bạn đừng quá lạm dụng hiệu ứng này, vì nó có thể thêm, nhưng
không phải là thêm những gì không có hoặc bị thiếu ở file ảnh gốc. Nhưng làm cho ảnh rõ
lên và có độ tương phản là những gì mà nó cung cấp cho bạn.

Unsharp Mask có lẽ là là công cụ tốt nhất để làm những hình đòi hỏi phải tỉ mỉ, chính
xác. Nó cho phép bạn thật sự kiểm soát độ nét của ảnh. Bạn hãy thử đặt độ nét như bạn
muốn. Radius xác định khoảng cách của từng pixel riêng biệt khi hiệu ứng được áp dụng.
Tôi khuyên bạn nên giữ nó ở mức thấp khoảng 2 Radius. Threshold xác định những pixel
giống nhau sẽ bị làm nét thêm, cho nên mức Threshold càng thấp độ tương đồng của các
pixel càng cao. Bạn tốt hơn hết là xem ví dụ dưới đây và thực hành với chính file hình của
bạn. Đó sẽ là cách tốt nhất

Chú ý: Photoshop filters không bị giới hạn chỉ của riêng PTS. Những sản phẩm khác
của  Adobe  như  là:  Pagemaker  và  Illustrator  cũng  có  thể  được  sử  dụng.  Thậm  chí
Macromedia's Director cũng dùng được một số hiệu ứng của PTS.
2.2.3. Distort Filters

Distort Filters là một trong những Filter được dùng khá phổ biến trong PTS. Tôi rất hay
dùng những hiệu ứng này, với tôi nó là những hiệu ưng tuyệt diêu! Nếu bạn là người giàu
trí tưởng tượng bạn có thể tạo ra những tác phẩm quên sầu!
2.2.3.1 Diffuse Glow Filter

Hiệu ứng này tạo ra những vùng sáng hoà trộn vào với file hình. Những tuỳ biến của nó
là: Graininess, Glow amount và Clear amount.

Để cho bức ảnh có tích thực tế, bạn nên giữ Grainines xuống thấp và bạn nên cân bằng
giữa độ Glow Amount và Clear Amount.

Graininess: 3
Glow Amount: 13
Clear Amount: 15

2.2.3.2 Glass và Ocean Ripple Filters
Hộp thoại Glass Filter và Ocean Ripple Filter
Tôi quyết định kết hợp hai hiệu ứng này làm một bởi vì tính tương đồng giữa 2 hiệu ứng

được thể hiện trên một file ảnh. Cả hai đều tạo ra cho bức ảnh có cảm giác như chúng được
nhìn qua kính hoặc nước.

Glass Filter cho bạn nhiều quyền kiểm soat hơn. Bạn có thể chọn loại Texture như là:
Frosty, Tiny lens hoặc Canvas. Và bạn cũng có thể Load vào một texture của bạn. Chỉ việc
chọn Load Texture từ menu thả xuống ở dưới cùng của hộp thoại.
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Sử dụng thanh trượt Smoothness để tăng tính "lỏng" của ảnh. Giữ Distortion thấp và
Smoothness cao sẽ có những bức ảnh tinh tế hơn. Bạn hãy thử một file với độ Distortion
thật cao!

Nút Invert ở cuối cùng của hộp thoại thay những màu sáng của texture thành màu tối và
ngược lại.

Một Filter nữa tôi muôn bàn thêm là Ocean Ripple Filter. Nó mang lại cho file hình của
bạn một cảm giác như là nó đang ở dưới nước. Đây là một Filter hiệu quả, và dễ sử dụng
hơn là Glass Filter. Tôi nghĩ với hai tuỳ biến Ripple Size và Magnitude làm cho nó dễ sử
dụng hơn nhiều. Phụ thuộc mục tiêu sử dụng của bạn, bạn có thể chọn Ocean thay vì Glass,
nhưng nếu bạn muốn có nhiều quyền kiểm soat hơn, bạn nên dùng Glass.
2.2.3.3 Pinch Filter

Hộp thoại Pinch Filter
Đây là một hiệu ứng rất tốt dùng để sửa ảnh. Nó hầu như lúc nào cũng phải dùng kết hợp

Marquee Selection Tool. Bởi vì thường thì bạn chỉ muốn "véo" một vùng nhất định của file
ảnh, chứ không phải toàn bộ.

Kéo một vùng lựa chọn bất kỳ ở một file ảnh
Áp dụng Pinch filter.

 Hãy chú ý đến vùng kẻ carô ở dưới cùng của hộp thoại Pinch khi bạn kéo thanh trượt
lên cao hoặc xuống thấp. Nó cho bạn biết trước được hiệu ứng gì sẽ tác động lên file ảnh và
như thế nào.

Đây là một Filter khá khó sử dụng, nhưng lại là một công cụ tốt mà bạn nên biết. Nó
có thể sẽ rất hữu dụng trong vài trường hợp, nhưng đừng dùng gượng ép, nếu nó không hợp
thì bạn nên chọn cái khác. Bạn cũng có thể điền vào giá trị âm vào thanh trượt để có hiệu
ứng "lồi ra", nhưng nếu nó không làm bạn vừa ý thì hãy thử với Spherize.
2.2.3.4 Shear Filter

Hộp thoại Shear
Shear Filter làm méo hình theo phương thẳng đứng. Nhấp và kéo đường thẳng trong

hộp thoại Shear và nhìn vào hình xem trước. Bạn cũng có thể tạo thêm nhiều vùng kiểm
soát bằng cách nhấp chuột vào những vùng khác nhau.  Những chấm này sử dụng kết hợp,
nó cho phép bạn định dạng hướng của hình cong.
Hiệu ứng này sẽ hiệu quả hơn nếu sử dụng kết hợp để tạo hình Gif động cho Website
2.2.3.5 Spherize Filter

Hộp thoại Spherize cũng gần giông như hộp thoại Shear.
Hiệu ứng này tạo ra một hình cầu ở giữa file ảnh của bạn (nếu không có vùng lựa

chọn được thiết lập). Bạn có thể dùng hiệu ứng này để tạo ra những hiệu ứng 3D rất hấp
dẫn. Bạn hãy chú ý đến dưới cùng của hộp thoại là một menu thả xuống, nó cho phép bạn
thay đổi hiệu ứng theo phương thẳng đứng hoặc phương nằm ngang.
2.2.3.6 Twirl Filter

Hộp thoại Twirl
Twirl filter cũng gần như cái tên của nó, nó tạo ra hiệu ứng xoay vòng của hình.

Trông gần như khi ta khuấy cốc nước. Bạn có thể điều khiển nó bằng thanh trượt trong hộp
thoại Twirl. Đây cũng là một công cụ khá hay để tạo ra những hiệu ứng đặt biệt, nhưng tôi
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chưa thấy được những điều tinh tế của Filter này, nhưng nếu bạn là người thông minh, bạn
sẽ làm được rất nhiều!
2.2.4 Stylize

Stylize filter cũng cho những hiệu ứng rất thú vị. Những filter này rất sáng tạo và hữu
dụng để sửa ảnh. Trong phần này chúng ta bàn về những hiệu ứng sau của Stylize Filter:
Find Edges, Glowing Edge và Wind
2.2.4.1 Find Edges Filter

Hiệu ứng này không thực sự tiện dụng vì khi bạn chọn lệnh nó sẽ được áp dụng ngay mà
không có hộp thoại điều khiển chỉ duy nhất hiệu ứng. Bạn có thể dùng Trace Contour để có
hiệu ứng tương tự
2.2.4.2 Glowing Edges Filter

Hộp thoại Glowing Edge
Đây là một hiệu ứng rất hấp dẫn. Nó có thể đổi ảnh của bạn qua màu của Web neon

chỉ trong vòng 1 giây, công việc mà có thể tôi và bạn phải mất đến hàng chục phút nếu làm
thủ công. Bạn điều khiên bao nhiêu đường biên bạn cần bằng thanh trượt trên cùng. Giá trị
càng cao thì đường biên càng rộng. Trong ví dụ này  tôi đặt là 3. Với tôi, giá trị này là lý
tưởng nhất.

Thanh trượt Edge Brightness điều khiển độ sáng của đường biên mà PTS định dạng
được. Nếu bạn để nó có giá trị cao, bạn sẽ được hình như tơ nhện như trong hình này tôi để
giá trị của thanh trượt là 12
Thanh trượt Smoothness xác định tổng số đường biên mà PTS có thể thấy. Đặt giá trị này
cao để có thêm nhiều đường biên của ảnh. Trong ví dụ này tôi dùng Smoothness là 12
2.2.4.3 Wind Filter

Hộp thoại Wind Filter
Wind filter tạo cho file hình một cảm giác như bị gió thổi xiên. Bạn có thể điều khiển

hướng "gió" và số lượng của "gió" trong hộp thoại. Đây là một hiệu ứng rất tuyệt để tạo
cảm giác của chuyển đọng như trong hình này. Nhưng bạn cũng nên nhớ sử dụng kết hợp
với công cụ Selection để điều chỉnh chỗ nào và như thế nào Wind filter được áp dụng.

Ví dụ của Wind filter. Tôi áp dụng 3 lần bằng cách nhấn Ctrl-F 3 lần.
2.2.5. Noise, Pixelate và Texture Filters

Cuối cùng tôi muốn nói đến hiệu ứng Noise, Pixelate và Texture Filter. Tôi cũng kết hợp
những filter này lại với nhau bởi vì tôi muốn bàn đến những đặc điểm chung của nó và
dùng một filter để làm rõ cho filter kia. Những filter này đều tạo ra hiệu ứng liên quan đến
nhau, nó không hoàn toàn thay đổi file hình của bạn (nhưng nó cũng có thể làm cho một
file ảnh biến đổi hoàn toàn với những giá trị tuỳ biến lớn). Nó không cuộn hoặc xoay
chuyển file hình mà nó chỉ thêm vào những hiệu ứng tinh xảo hơn.
2.2.5.1 Noise Filters

Hộp thoại Add noise
The Noise filters thêm vào Graininess (dạng hạt) cho một file ảnh bởi vì trong thế giới

kỹ thuật số, có những bức ảnh quá thật đến thành giả tạo :d. Nhưng trái lại với nó là hiệu
ứng Despeckle, nó làm cho file ảnh thêm mịn.
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Bạn có thể mở một file ảnh bất kỳ đê thực hành.  Tôi khuyên bạn nên dùng Uniform
Distribution. Gaussian có vẻ hơi mạnh quá. Bạn hãy thử undo add noise thay các hiệu ứng
như là Dust & Scratches.

Đối với Filter này, bạn nên giữ Radius thấp khoảng 1 hoặc 2. Nếu không mọi thứ sẽ lẫn
lộn và nét tinh tế của tấm hình sẽ mất.

Giữ Threshold là 0 hoặc 1 để có kết quả tốt nhất. Bằng cách đó, giá trị của tất cả các đơn
vị pixel trong file hình sẽ được tính tới và bạn sẽ nhìn thấy những thay đổi. Nếu bạn để nó
cao hơn 10 hoặc 20 bạn hầu như không nhìn thấy thay đổi gì trong hình.
2.2.5.2 Pixelate Filters

Hộp thoại Crystallize
Những hiệu ứng này tạo ra những hiệu ứng về Texture tuyệt với. Những hiệu ứng này

cũng có thể được sử dụng để tạo ra những hiệu ứng khủng khiếp nhất, xấu xí nhất và trung
thực nhất. Nào! hãy để cảm nhận về hội hoạ của bạn trỗi dây! tôi tạm thời ngậm miệng lại
một lúc.

Bạn đã khám phá ra gì chưa? nào! chúng ta cùng tìm hiểu! bạn hãy mở một file ảnh bất
kỳ.

Chọn Filter > Pixelate >Crystallize. Hiệu ứng này lấy những pixel màu và biến nó thành
những vùng màu chung được gọi là ô. Nếu giá trị Cell của bạn càng cao, thì ô trong hình
của bạn càng lơn. Nếu bạn để giá trị khoảng hơn 20 thì nó sẽ mất đi những gì của file hình
và mọi thứ trở lên không rõ ràng và góc cạnh.
Bạn sẽ nhận ra với giá trị là 24, bạn sẽ không còn nhìn thấy nó là hình gì nữa và có thể bạn
nghĩ cái thằng cha nào làm ở trong nhóm Adobe lập trình cho phép bạn đến tận kích cỡ thứ
300?

Rất đơn giản, vì hiệu ứng phải được dụng kết hợp với nhau, không phải luôn luôn nhưng
thông thường. Phần này đi ra ngoài phạm vi của cuốn sách, nhưng nếu bạn đã đọc đến phần
này, bạn đã sẵn sàng có những quyết định riêng của mình. Crytallize được thiết lập với giá
trị Cell là 24 sẽ chẳng cho bạn ích lợi gì, nhưng thử kết hợp với Stylize > Glowing Edge
filter xem! Tôi thử nó với những hiệu ứng khác. Bạn có thể kết thúc với một đống bùng
nhùng, nhưng đừng quá chán nản. Hãy Undo và thử với cái khác! các nhà bác học muốn
phát minh ra những thứ cho chúng ta dùng hiện nay cũng chẳng phải đã làm hỏng hàng
nghìn thứ mới có được một thứ dùng được. Có ai nói ông ý phá hoại đâu!
Hầu hết những hiệu ứng khác trong dòng Pixelate Filter đều có những hiệu ứng khá tương
đương với những gì chúng ta đã làm. Nó phá vỡ file hình của bạn thành từng mảnh nhỏ,
hoặc từng đơn vị pixel, to hoặc nhỏ

Một hiệu ứng nữa là Color Halftone filter nó phá vỡ file hình thành những giá trị bán
sắc. Bạn có thể điều khiển giá trị Radius và Angle. Đây là một hiệu ứng khá hay khi dùng
trong nghệ thuật cắt dán ảnh để dựng lại những phần của một bức ảnh.
2.2.5.3 Texture Filters

Có rất nhiều hiệu ứng Texture có điểm tương đồng với những hiệu ứng trong dòng
Pixelate và Noise Filter. Stained Glass rất giống với Crytallize, Grain giống với noise và
Mosaix Tiles giống với Craquelure - Hiệu ứng ở ngay trong dòng Texture Filter
Hãy mở một file ảnh bất kỳ
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Hiệu ứng đầu tiên chúng ta thực hành là Craquelure. Đây là hộp thoại của nó. Filter >
Texture > Craquelure

Trong hộp thoại này bạn có thể đặt giá trị như Crack spacing, Crack depth và Crack
brightness. Hiệu ứng nhìn như là bức ảnh được làm bằng kim loại lồi lõm Bạn cũng có thể
sử dụng kết hợp với Dust & Scratches vào file hình này.

Một hiệu ưng tương tự, nhưng theo ý kiến của riêng tôi, Patchwork là hiệu ứng đẹp hơn.
Nó tạo ra hiệu ứng như lát đá cho ảnh của bạn. Đây thực sự là một hiệu ứng tuyệt diệu và
có thể được dùng để tạo ra những tác phẩm cực kỳ hấp dẫn.

Bạn có thể điều chỉnh kích cỡ của Square và Relief dựa vào thanh trượt. Với giá trị càng
nhỏ, hình "lát đá" càng mịn. Giá trị Relief càng cao, độ thẳng hàng của vùng lát đá càng
kém.

Bài tập: Tạo hiệu ứng chữ với những bức ảnh đã làm ở bài 4
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Tài liệu tham khảo:
Phùng Thị Nguyệt - Phạm Quang Huy, Bài tập thực hành Photoshop 7.0 & Photoshop

Cs nâng cao, Nhà XB Giao Thông Vận Tải -  Năm 2007
Nguyễn Anh Dũng, Adobe Photoshop & ImageReady 7.0 - Tập 2,, NXB: Lao động xã

hội – Năm 2007
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